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The Measure Data Acquisition User Manual describes how to use the

Measure Data Acquisition Add-In with National Instruments data

acquisition boards to acquire data into Microsoft Excel.  You should be

familiar with the operation of Microsoft Excel, your computer, your

computer’s operating system, and your data acquisition (DAQ) board.

Organization of This Manual

The Measure Data Acquisition User Manual is organized as follows.

• Chapter 1, Introduction, helps you install the Measure Data

Acquisition (DAQ) Add-In. You should have installed and

configured your DAQ hardware already.

• Chapter 2, Getting Started with Data Acquisition Tasks, contains a

tutorial for the following basic functions: selecting a data

acquisition task, configuring an analog input task, configuring an

analog output task, adding tasks to the DAQ menu, saving tasks,

and managing tasks in a workbook.

• Chapter 3, Using SCXI with Measure DAQ, describes how to use

the Measure Data Acquisition Add-In in Excel with your Signal

Conditioning Extension for Instrumentation (SCXI) equipment.

• Chapter 4, Analog Input Reference, introduces some basic

concepts of data acquisition and contains a reference for analog

input configuration, hardware digital triggering, analog input

modes, and advanced timing. You should be familiar with the

hardware characteristics of your data acquisition device.

• Chapter 5, Analog Output Reference, introduces some concepts of

data acquisition and contains a reference for basic and advanced

Analog Output Configuration.
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• Chapter 6, Using Measure Data Acquisition Tasks with VBA,

describes how to run tasks from within Visual Basic for

Applications.

• Appendix A, DAQ Hardware Capabilities, contains tables that

summarize the analog I/O capabilities of National Instruments data

acquisition devices you might use with Measure for Windows.

• Appendix B, Error Codes, describes the errors that can occur

while using the Measure DAQ Add-In.

• Appendix C, Troubleshooting, describes solutions to problems that

you might encounter using the Measure DAQ Add-In.

• Appendix D, Customer Communication, contains forms you can

use to request help from National Instruments or to comment on

our products and manuals.

• The Glossary contains an alphabetical list and descriptions of

terms used in this manual, including abbreviations, acronyms,

metric prefixes, mnemonics, and symbols.

• The Index contains an alphabetical list of key terms and topics in

this manual, including the page where you can find each one.

Conventions Used in This Manual

The following conventions are used in this manual.

bold Bold text denotes a parameter, or the introduction of menus, menu

items, or dialog box buttons or options.

bold italic Bold italic text denotes a note, caution, or warning.

italic Italic text denotes emphasis, a cross reference, or an introduction to a

key concept.
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monospace Text in this font denotes text or characters that are to be literally input

from the keyboard, sections of code, programming examples, and

syntax examples.  This font is also used for the proper names of disk

drives, paths, directories, programs, subprograms, subroutines, device

names, functions, variables, filenames, and extensions, and for

statements and comments taken from program code.

» The » symbol leads you through nested menu items, and dialog box

options to a final action.  The sequence Files»Page Setup»

Options»Substitute Fonts

directs you to pull down the File menu, select the Page Setup item,

select Options, and finally select the Substitute Fonts option from the

last dialog box.

Note: This icon to the left of bold italicized text denotes a note, which

alerts you to important information.

Related Documentation

The NI-DAQ User Manual for PC Compatibles contains information

that you may find helpful as you read this manual.

Customer Communication

National Instruments wants to receive your comments on our products

and manuals.  We are interested in the applications you develop with

our products, and we want to help if you have problems with them.  To

make it easy for you to contact us, this manual contains comment and

configuration forms for you to complete.  These forms are in

Appendix D, Customer Communication, at the end of this manual.
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Introduction

This chapter helps you install the Measure Data Acquisition (DAQ)

Add-In. You should have installed and configured your DAQ hardware

already. If you have not done so, please refer to the NI-DAQ

documentation that came with your device for instructions on

installation and configuration.

Using Measure with Your DAQ Device

Measure is designed to work with many different National Instruments

DAQ devices. Before you can use Measure, you must install and

configure your DAQ device and the NI-DAQ driver software that came

with your DAQ device. NI-DAQ is the low-level driver software that

controls your DAQ device. Measure is a higher-level software

development tool that communicates to your DAQ device through

NI-DAQ. Refer to the documentation that comes with your DAQ

device to learn how to install it properly.

Once you install your DAQ device, you must install and configure your

NI-DAQ driver software.

You use the NI-DAQ Configuration Utility to set up your DAQ device.

For some DAQ devices, such as the E Series boards, you do not have

to configure many settings. For other devices, you might be required to

set jumpers or switches on your device to configure it to work in your

system. Refer to the documentation that came with your DAQ device

to install your NI-DAQ driver software. The filename for the NI-DAQ

Configuration Utility is WDAQCONF.EXE in NI-DAQ versions 4.0 and

earlier. In NI-DAQ versions 5.0 and later, the filename is

NICFG16.EXE for Windows 3.1 and NIDAQCFG.EXE for Windows

95/98 or Windows NT 4.0.
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Configuring Channels with the Channel Wizard

The NI-DAQ Configuration Utility is a Windows application you can

use to configure the analog input channels on your DAQ device. The

Channel Wizard feature helps you define the physical quantities you

are measuring on each DAQ hardware channel. As you configure

channels in the Channel Wizard, you give each channel configuration a

unique name that is used when addressing your channels in Measure.

The channel configurations you define are saved in a file that instructs

the NI-DAQ driver how to scale and process each DAQ channel by its

name. National Instruments recommends that you use the Channel

Wizard to configure the analog input channels for your DAQ device.

Refer to the NI-DAQ Configuration Utility online help for specific

instructions on how to use the Channel Wizard. In Windows 95/98 or

Windows NT 4.0, you can find the help file in Start»Programs»

National Instruments DAQ»NI-DAQ Help.

DAQ Device Overview

Measure is an easy-to-use spreadsheet interface for acquiring data with

a wide range of National Instruments DAQ devices. Because Measure

works with so many different devices, the functionality and

performance of the software often varies based on the particular DAQ

device you use. Although Measure senses the type of DAQ device you

are using, you might select options in the task configuration that are not

supported by your particular device. Measure notifies you when such a

conflict occurs when you close the configuration window, or when you

test the task you have defined. Make sure to test each task once you

define it.

The following pages contain a tutorial to show you how to use

Measure. Refer to the Managing Tasks in a Workbook section in

Chapter 2, Getting Started with Data Acquisition Tasks, for detailed

information on the analog input and output settings you can configure

with Measure.



Chapter 1    Introduction

© National Instruments Corporation 1-3 Measure Data Acquisition User Manual

Installing Measure

1. Insert the Measure 2.0 CD into the CD-ROM drive .

2. Select Start»Run from the taskbar in Windows 95 or File»Run

from the Program Manager in other versions of Windows.

3. Type X:\SETUP in the box labeled Command Line, and then

select OK.

4. Select a location for the setup program to install Measure for

Windows.

5. Deselect any Add-Ins that you do not want to install.

6. Select OK.

The setup program copies the program files and on-line help files to the

directory that you choose and creates a program group. Setup also

automatically configures Excel to load the DAQ Add-In when you

launch Excel. If you do not want Excel to automatically load the DAQ

Add-In, remove the Add-In manually as described in the following

section.

Manually Adding or Removing the DAQ Add-In
To add the DAQ Add-In manually, complete the following steps.

1.  In Excel, select Tools»Add-Ins.

2.  In the Add-Ins dialog box, search the Add-Ins Available list box

for the Measure Data Acquisition Add-In entry. Click in the

checkbox next to the Measure Data Acquisition Add-In entry. If

you cannot find the entry, click the Browse button and look for

DAQ.XLA in the directory where you installed Measure.

To remove the DAQ Add-In manually, deselect the checkbox next to

it, as shown in Figure 1-1. The next time you launch Excel, Excel will

not load the DAQ Add-In automatically.
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Figure 1-1.  Add-Ins Dialog Box

Uninstalling Measure

To uninstall Measure, remove Serial, Data Acquisition, and GPIB

Add-Ins from the Add-Ins list in Excel. Double-click the Uninstall

icon in the Measure folder to remove Measure from your computer.
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Getting Started with

Data Acquisition Tasks

After you install and configure your hardware and install the Measure

Data Acquisition Add-In, you are ready to acquire data. This chapter

contains a tutorial for each of the following basic functions.

• Selecting a Data Acquisition task

• Configuring an Analog Input task

• Configuring an Analog Output task

• Adding tasks to the DAQ menu

• Saving tasks

• Managing tasks in a workbook

You only need to read the sections for the functions that you use in

your application.

Selecting a Data Acquisition Task

This section contains step-by-step instructions for configuring analog

input and output tasks with Measure. To configure tasks, complete the

following steps.

1. Launch Excel.

2.  Select DAQ»Configure DAQ Tasks to display the DAQ Tasks

dialog box, as shown in Figure 2-1.
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Figure 2-1.  DAQ Tasks Dialog Box

The DAQ Tasks dialog box manages the I/O operations, or tasks,

that you define with Measure. From this dialog box, you can create

new tasks, edit existing tasks, and run I/O tasks interactively to test

their operation.

3.  Select a DAQ device from the Data acquisition device drop-down

listbox at the top of the dialog box. The list of devices available in

the drop-down listbox is taken from the devices that you have

configured. If you configured your channels with the Channel

Wizard, select Use Named Channels in the list box. If you have

not run the configuration utility yet, refer to the documentation

that came with your DAQ hardware.

4.  Click on the AI button to display the Analog Input Configuration

dialog box, as shown in Figure 2-2.
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Figure 2-2.  Analog Input Configuration

Configuring an Analog Input Task

From the Analog Input Configuration dialog box, you can specify all

the parameters for an analog input operation. In the following steps,

you create a simple analog input task. Refer to Chapter 4, Analog Input

Reference, for more detailed information about the different options for

analog input.

1. The Analog Input Scan List at the top of the dialog box is where

you specify the input channels on your DAQ device from which

you would like to acquire data. For each input channel you add to

the scan list, you must specify a high- and low-voltage limit for the

signals you read. Measure puts default values for your device in

the high- and low-limit fields. Measure uses these limits to

configure the gain settings on your DAQ device for maximum

measurement accuracy.

Type 0 in the Channel field and click on the Add>> button to

place the channel into your scan list. If you are using named

channels, type the channel name in the Channel field and click on

the Add>> button to place the named channel in you scan list.

You cannot mix channels from multiple devices within a task.
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Note: The High limit and Low limit fields and the Mode button are disabled in the

Analog Input Configuration dialog box when you select Use Named

Channels for your data acquisition device in the DAQ Tasks dialog box.

2. In the Scan Information section of the dialog box, you specify how

many scans of your channel list are to be acquired. A scan is a

single measurement from each channel in your scan list. In this

example in which there is only one channel specified, the number

of scans is equal to the number of points acquired from Channel 0.

If you specified two channels in your channel list, 100 scans

would result in 200 points of data acquired (100 from each

channel).

Type 100 in the Number of Scans field.

3. The Scan Rate section of the dialog box is where you specify how

fast you would like to acquire the data. The default setting of 1000

scans per second means that you acquire a single point from each

channel in your channel list 1000 times per second.

Type 1000 in the Scans/second field.

4. The Display section of the dialog box is where you specify the

cells on your worksheet to contain the acquired data. You

manually can type in a spreadsheet address, such as $A$1, or you

can highlight the input field and use your mouse to select an area

on the spreadsheet to place your acquired data. Measure begins

with the upper-left most cell in the range that you supply and

places the data in rows or columns from that point in the

worksheet.

Type $A$1 to place the 100 elements of data in the first column of

your worksheet.

5. Type the name Read Channel 0 in the Task Name field.

6.  Click on the Description button to add a description for your task

under development, as shown in Figure 2-3. Type Acquire

100 points of data from channel 0 in the Task

Description dialog box, and click on the OK button.

Now you have finished specifying your first Measure analog input

task.
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Figure 2-3.  Task Description Dialog Box

7.  Click on the OK button to return to the DAQ Tasks dialog box, as

shown in Figure 2-4. Notice that you now have a task named

Read Channel 0 in your task list and that the description for

this new task appears in the dialog box as well.

Figure 2-4.  DAQ Tasks Dialog Box

8. Click on the Run button to execute the task. When the task

completes, there are 100 datapoints in column A of your

worksheet.
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Configuring an Analog Output Task

If your DAQ device has analog output channels, you can use Measure

to generate analog output signals based on values in your spreadsheet.

You use analog output tasks to generate signals. You specify an area

on your worksheet that contains data values, and Measure converts

these values to voltages and outputs them through an analog output

channel of your DAQ device. For more information on analog output

tasks, refer to Chapter 5, Analog Output Reference.

1.  In the DAQ Tasks dialog box, click on the AO button to display

the Analog Output Configuration dialog box, as shown in

Figure 2-5.

Figure 2-5.  Analog Output Configuration Dialog Box

Note: The Advanced button is disabled in the Analog Output Configuration dialog

box when you select Use Named Channels for your data acquisition device in

the DAQ Tasks dialog box.

2. Type 0 in the Channel input field. If you are using named

channels, type the channel name in the Channel field.

3.  Type $A$1:$A$10 in the Data cells input field. You can type

this range manually, or highlight the input field and drag particular

areas of your worksheet to specify a cell range. This parameter

specifies which cell values are used as analog output values.

4.  Click on the Add button.
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5.  Type 10 in the Number of iterations input field. The number of

iterations determines how many times Measure outputs the values

specified in the cell range. You can type a value of 0 in this field

for continuous output of the values.

6.  Type 1000 in the Updates per second input field. As in acquiring

data, you must specify an update rate to determine how fast the

data outputs through the analog output channel.

7.  Type Output 10 iterations in the Task Name input field.

8.  Click on the Description button, and type Output 10

iterations of data on analog output Channel 0

for the description of your analog output task. Click on the OK

button.

9.  Now you have finished configuring your first Measure analog

output task. Click on the OK button to return to the DAQ Tasks

dialog box. Notice that your new analog output task appears in the

task list, as shown in Figure 2-6.

Figure 2-6.  DAQ Tasks Dialog Box

10. Highlight the Output 10 iterations task and click on the

Run button to execute the analog output task. Make sure you have

valid voltage data in cells A1:A10 before running the task.
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Adding Tasks to the DAQ Menu

Now that the two tasks are configured and tested from the DAQ Tasks

dialog box, you might want to make them more accessible from your

spreadsheet. With Measure, you can easily add these tasks to the DAQ

menu.

1. Select DAQ»Configure DAQ Tasks.

2. Click on the Edit Menu button to display the Edit DAQ Menu

dialog box, as shown in Figure 2-7.

Figure 2-7.  Adding Tasks to the DAQ Menu

3. Highlight each of the tasks in the window on the right and click on

the Add button to add them to the DAQ menu.

4. Click on the OK button to return to the Configure DAQ Tasks

menu. Click on the OK button to return to the Excel worksheet.

5.  Pull down the DAQ menu. Notice that two new entries now appear

in the DAQ menu, as shown in Figure 2-8. Now you can select

these tasks and execute them from the worksheet without going

into the Measure dialog boxes.

Figure 2-8.  The DAQ Menu
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Saving Tasks

Each of your tasks are stored in your workbook automatically when

you click on the OK button in the DAQ Tasks dialog box. If you

configure a new task, but click on the Cancel button from the DAQ

Tasks dialog box, Measure does not store your new task in your

workbook.

Your tasks are saved as part of the Excel workbook. Each time you

launch Excel and open a workbook that contains Measure tasks, they

appear in the task list of the DAQ Tasks dialog box.

Managing Tasks in a Workbook

This section describes how to use the DAQ Tasks dialog box, as shown

in Figure 2-9, to manage the tasks in a workbook. You can open this

dialog box by selecting DAQ»Configure DAQ Tasks from the menu

bar.

Figure 2-9.  DAQ Tasks Dialog Box
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Table 2-1 contains a list of the DAQ Tasks dialog box options with

descriptions of their use.

Table 2-1.  DAQ Tasks Dialog Box Options

Option/Button Description

Data acquisition device Select the National Instrument data acquisition device for which you

want to create a task. Measure scans your NI-DAQ configuration for

installed devices and lists only those devices that Measure supports.

Data acquisition tasks Measure lists all the tasks that you have created for a data acquisition

device. Select a task if you wish to run, edit, or delete it.

Task Description Measure displays the description of the selected task. You can assign a

description to a task when you create or edit it.

Edit Menu Add or delete tasks from the DAQ menu.

AI Create an Analog Input task for the selected data acquisition device.

AO Create an Analog Output task for the selected data acquisition device.

Run Run the selected data acquisition task.

Edit Edit the selected data acquisition task.

Delete Delete the selected data acquisition task.

OK Store in the active workbook all the changes that you made (creation of

tasks, changes to existing tasks, deletions of tasks, additions or

deletions to the DAQ menu).

Cancel Ignore all the changes that you made (creation of tasks, changes to

existing tasks, deletions of tasks, additions or deletions to the DAQ

menu).
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Using SCXI

with Measure DAQ

This chapter describes how to use the Measure data acquisition (DAQ)

Add-In in Excel with your Signal Conditioning Extension for

Instrumentation (SCXI) equipment.

SCXI is a set of modules and terminal blocks used as a signal condition

front-end for your data acquisition devices. These modules perform

tasks such as multiplexing large numbers of signals, amplifying low-

level signals, providing isolation between your data acquisition devices

and transducers, and so on.

To use your SCXI modules with Measure, you must first configure all

your DAQ hardware using the NI-DAQ Configuration Utility. In the

configuration utility, you must assign a device number to each of your

DAQ devices and define the connections to your SCXI modules. In

most cases, your DAQ device is a plug-in board in your computer,

although it also can be a PC Card (PCMCIA) format DAQCard or a

SCXI-1200 module. You use the DAQ devices for the actual A/D

conversions of your analog input signals and for controlling SCXI

modules. Each SCXI module is controlled by one DAQ device and is

assigned as such in the configuration utility. If you have any questions

about the NI-DAQ Configuration Utility, consult the NI-DAQ

documentation.

Once you have configured the SCXI system, using the Measure DAQ

Add-In is very similar to using other DAQ devices. The only difference

in the operation is the use of the channel string in the scan list to

specify the channels on specific SCXI modules you want to acquire.

All other parameters of the DAQ Add-In operate the same.

SCXI Operating Modes

You can operate SCXI modules in two different modes-multiplexed

and parallel. In the multiplexed mode, all analog input channels for

each SCXI module are multiplexed (routed) onto one input channel of
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your data acquisition device. The multiplexed mode is the default and

recommended mode to use with SCXI. In the parallel mode, each SCXI

module is directly connected to one data acquisition device and each

analog input channel on a SCXI module is connected to a separate

analog input channel on the data acquisition device. Not all data

acquisition devices or SCXI modules support the parallel mode.

Consult your data acquisition hardware user manual for more

information.

SCXI Analog Input
The following information is not relevant if you used the Channel

Wizard to configure your channels.

To configure channels on a SCXI analog input module in the DAQ task

configuration, select the DAQ device in the main DAQ Tasks dialog

box to which the SCXI module is directly or indirectly connected.

Then, click on the AI button to create an AI task or the Edit button to

modify an existing AI task. In the Analog Input Configuration dialog

box, specify the SCXI channel(s) you want to acquire in the Channels

field by entering a channel string. This channel string provides

information about the DAQ device channel, SCXI chassis number,

SCXI module number, and SCXI channel number. The channel string

has the following format:

ob0!scx!mdy!z

In the SCXI channel string, x represents the chassis number, y the

module number, and z the channel number.

‘ob0’ in the SCXI channel string indicates which onboard channel (on

the DAQ device) to use to acquire the data. In the SCXI multiplexed

mode (default mode), all SCXI channels from one SCXI chassis are

multiplexed onto one onboard channel. Usually, this is Channel 0 (ob0

in the SCXI string), unless you are using more than one SCXI chassis;

in which case each additional chassis uses the next onboard channel

(i.e. Chassis 2 uses onboard Channel 1, and so on).

‘scx’ represents the chassis number where x is replaced by the actual

number (e.g. sc1). The chassis are numbered starting with 1 and the

chassis number is assigned in the NI-DAQ Configuration Utility.

‘mdy’ represents the module number where y is replaced with the

actual number (e.g. md2). The modules are numbered 1 through n on
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each SCXI chassis with module 1 being in the left-most slot of the

SCXI chassis and module n in the right-most slot.

‘z’ in the SCXI channel string represents the actual channel number

(e.g. 3). Channels on the SCXI modules are numbered starting at zero.

You specify a range of channels on your SCXI modules by listing the

first and last channel separated with a colon (e.g. 0:5).

You use the SCXI channel string only when the SCXI is operating in

multiplexed mode and channels are multiplexed onto one or more

channels of the data acquisition device. In parallel mode, specify the

channel of your data acquisition device to acquire. Each channel on

your DAQ device is mapped in hardware to one channel on a SCXI

module in parallel mode.

Multiple SCXI Modules and Chassis
The following information is not relevant if you used the Channel

Wizard to configure your channels.

In the scan list of your DAQ AI task, you can specify channels from

multiple SCXI modules or chassis by adding multiple entries to the

scan list. Repeat the Add operation for each SCXI module. However,

you can specify only one group of consecutive channels per SCXI

module in the scan list. You must specify consecutive channels in an

incremental order (e.g. ob0!sc1!md1!0:5,

ob0!sc1!md2!10:19). In the DAQ Tasks dialog box, the channel

setting would be listed as follows. The two lines in the scan list on the

right are added separately by twice filling in the channel field on the

left and clicking on the Add>> button, as shown in

Figure 3-1.
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Figure 3-1.  Selecting the Add>> button

Table 3-1 lists other possible combinations for SCXI channel strings.

Table 3-1.  SCXI Channel Strings Syntax

String Syntax Description

ob0!sc1!md2!5 Channel 5 on module 2 of SCXI Chassis 1 is read through

onboard Channel 0.

ob0!sc1!md2!0:7

ob0!sc1!md4!5:12

Channels 0-7 on Module 2 and Channels 5-12 on Module

4 of Chassis 1 are read through onboard Channel 0.

ob0!sc1!md3!3:4

ob1!sc2!md1!20:24

Channels 3 and 4 of Module 3 of Chassis 1 are read

through onboard Channel 0, and Channels 20-24 of

Module 1 on Chassis 2 are read through onboard

Channel 1.

In the parallel mode, each analog input SCXI module is connected

directly to a DAQ device and you must specify the channels of your

DAQ device in the channel list, not the SCXI channel string.

Note: The SCXI-1200 does not support the parallel mode with other SCXI modules.
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SCXI Analog Output
Only the SCXI-1124 module supports AO channels. This module has

six AO channels per module. The channels support only single-point

updates, and there is no waveform generation. SCXI AO channel

strings are structured the same as SCXI AI channel strings but without

the ‘ob0’ in front.
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Analog Input Reference

This chapter introduces some basic concepts of data acquisition and

contains a reference for analog input configuration, hardware digital

triggering, analog input modes, and advanced timing. You should be

familiar with the hardware capabilities of your data acquisition device.

DAQ Device Overview

Measure works with a wide variety of National Instrument DAQ

devices. This chapter provides a technical overview and reference

information about using Measure for analog input operations. Many of

the parameters that you can set up with Measure vary depending on

your DAQ device. For example, DAQ devices vary in acquisition

speed which affects how fast you can acquire data using Measure.

In addition, some DAQ devices have more extensive triggering

capabilities than other DAQ devices. Measure does not disable any of

its options according to the selected DAQ device.  When selecting

options which are not supported by a particular DAQ device, you get

an error message during configuration or testing. Refer to the

documentation included with your DAQ hardware to learn more about

the particular capabilities of your DAQ device.
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Analog Input Configuration Overview

Select DAQ»Configure DAQ Tasks and then click on the AI button

to open the Analog Input Configuration dialog box, as shown in

Figure 4-1. The following sections describe the fields within the

Analog Input Configuration dialog box, and Table 4-2 explains the

remaining options at the bottom of the Analog Input Configuration

dialog box.

Note: The High limit and Low limit fields and the Mode button are disabled in the

Analog Input Configuration dialog box when you select Use Named

Channels for your data acquisition device in the DAQ Tasks dialog box.

Figure 4-1.  Analog Input Configuration Dialog Box

Analog Input Scan List
To configure an acquisition, you must select the channels that you want

to scan by entering a channel string in the Channels field. If you

configured your channel with the Channel Wizard, you must select the

channels you want by entering a channel name in the Channels field.

A scan is one acquisition or reading from each channel in the Analog

Input Scan List. The scan list can have multiple entries of one or more

channels. Each entry has its own set of high and low limits which

determines the gains on the channels in the entry.
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Channels
Specify channels to add to the scan list. A channel string can consist of

a named channel defined with the Channel Wizard, a single channel, a

list of channels delimited by commas, a range of channels denoted by

the first and last channel of the range separated by a colon, or any

combination of the previous three types of syntax. The order that you

specify the channels in your channel string from left-to-right is the

order that Measure scans the channels. The following is a table of valid

channel strings.

Table 4-1.  Examples of Valid Channel Strings

Valid Channel Strings Channels in the Scan List

9 9

3,1 3, 1

4:7 4, 5, 6, 7

9,4:7,3,1 9, 4, 5, 6, 7, 3, 1

0,1 (using one AMUX board) 0, 1, 2, 3, 4, 5, 6, 7 on the AMUX board

0 (using two AMUX boards) 0, 1, 2, 3 on the first AMUX board and 0, 1, 2, 3 on the

second AMUX board

ob0!sc1!md1!0:3 0, 1, 2, 3 on the SCXI module in the first slot of the first

chassis

0b0!sc1!md3!0:4,

ob0!sc!md4!7

0, 1, 2, 3, 4 on the SCXI module in the third slot of the

first chassis and 7 on the SCXI module in the fourth slot

of the first chassis

ob0!sc1!md2!20:22,

ob1!sc2!md3!5:8

20, 21, 22 on the SCXI module in the second slot of the

first chassis and 5, 6, 7, 8 on the SCXI module in the

third slot of the second chassis

For more information about using SCXI, refer to Chapter 3, Using

SCXI with Measure DAQ.

Note: Some devices, such as the 1200-Series, have a fixed scanning order. If you are

using a device that has a fixed scanning order and you want to scan multiple

channels, you must list the channels in the scan list in descending order with

the last channel in the scan list being Channel 0 (for example, 3, 2, 1, 0). If

you are using such a device in differential mode, you must use the even-

numbered channels (for example, 6, 4, 2, 0).
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High Limit
Enter the upper voltage limit for the channels in the channel string.

This voltage is the maximum voltage that is measured at any of the

analog input channels that you specify in the channel string. You can

add more than one channel string to your scan list and each channel

string can have a different set of high and low limits. When you create

an AI task, Measure enters the default value for the device. If you are

using named channels, this field is not available.

Low Limit
Enter the lower voltage limit for the channels in the channel string.

This voltage is the minimum voltage measured at any of the analog

input channels that are specified in the channel string. You can add

more than one channel string to your scan list and each channel string

can have a different set of high and low limits. When you create an AI

task, Measure enters the default value for your device. If you are using

named channels, this field is not available.

Note: Not all devices can have scan lists in which different channels can have

different high and low limit settings.

Scan Information
The following options apply to all channels in the scan list.

Number of Scans
Specify the number of scans for the acquisition. The number of scans is

the number of data acquisitions or readings to acquire from each

channel.

Scale to Volts
Select this option if you want Measure to display the acquired data in

volts. Otherwise, Measure displays the data as the binary values read

from the analog-to-digital converter (ADC).

Timing Settings
A scan as a snapshot of the voltages present on your channels at a

given instant. The scan rate determines how many scans per second

Measure executes, which means that Measure samples each channel at

the scan rate you choose. If you set your scan rate to 10 scans per
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second, you are taking 10 snapshots each second of all the channels in

your scan list. If Channel 2 is in your scan list, you sample Channel 2

ten times per second. Your scan rate is your sampling rate per channel.

In reality, your device does not take a snapshot of all your channels

instantaneously, unless it has the capability to do simultaneous

sampling. Rather, for each scan (as timed by the scan clock), the device

proceeds from one channel in the scan list to the next depending on the

channel clock rate. The faster the channel clock rate, the more closely

in time the channels are sampled within each scan. The reciprocal of

the channel clock rate is called the interchannel delay, or channel

interval, as shown in Figure 4-2.

Figure 4-2.  Scan Clock and Channel Clock

Measure automatically calculates the smallest, safe interchannel delay

for your given configuration and device. If you select a scan rate that

requires an interchannel delay smaller than the safest interchannel

delay, Measure returns a warning and uses round-robin scanning.

Round-robin scanning means that the interval between the last channel

in one scan and the first channel of the following scan is the same as

the interval between any two channels in the middle of the scan, as

shown in Figure 4-3.

Figure 4-3.  Round Robin Scanning

Scans/Second
Enter a scan rate for the acquisition in this field.

External Scan Clock
Select this option if you want to use an external signal for generating

the scan rate. Measure uses the signal on an I/O line on the connector

of your DAQ device for generating the scan clock.
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Note: For MIO-E Series devices, the external scan clock signal is connected to the

PFI7 pin. For most other devices, the external scan clock signal is connected

to the OUT2 line. Refer to the user manual for your DAQ device for more

information.

Display
When determining where to display the acquired data, Measure uses

three pieces of information you specify.

• Address of the upper-left cell in the range you select

• Orientation of the channels you select (in rows or columns)

• Number of channels in the scan list

For example, if your scan list has four channels and the upper-left cell

of the range has the address A5 and you specify In columns for the

orientation, Measure displays the first scan of data in cells A5:D5, the

second in A6:D6 and so on. The acquired data from the first channel in

your scan list is displayed in the column headed by cell A5, the

acquired data from the second channel in your scan list is displayed in

the column headed by cell B5, and so on.

At Cell
Specify the target range of the acquired data. Either explicitly type the

cell address, or highlight the text in this field and select a cell on any

worksheet in the workbook. Measure automatically records the address

of your selection in this field.

In Columns
Select this option if you want to display your data in a channel per

column orientation.

In Rows
Select this option if you want to display your data in a channel per row

orientation.

Table 4-2 contains a list of the choices for the Analog Input

Configuration dialog box with descriptions of their use.
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Table 4-2.  Analog Input Configuration Buttons/Options

Option/Button Description

Task Name When you create a new AI task, Measure suggests a unique name for

your new task. You can specify a name that is unique to the currently

active workbook for this task.

Trigger Most data acquisition devices have a hardware digital trigger input

(TTL level). Click this button to configure a digital trigger for your

device.

Mode Change the analog input mode from the setting that you specify when

you run the NI-DAQ Configuration Utility. Measure automatically

selects the option that reflects the current setting for your device.

Description Enter a short description of your task. Measure displays a description

of a task below the task list in the DAQ Tasks dialog box. Also, if you

add your task to the DAQ menu,  Measure displays the task description

in the Excel status bar at the bottom of its window when you select the

task in the menu.

OK Verify configuration and add a new task or update an existing task in

the data acquisition tasks lists. Return to the DAQ Tasks dialog box.

Cancel Ignore changes and return to the DAQ Tasks dialog box.

Trigger Reference

On most DAQ Series devices, you can configure a digital trigger that

starts an acquisition, that stops an acquisition, or both. To set up a

hardware trigger, select Analog Input Configuration»Trigger to open

the Hardware Digital Trigger dialog box, as shown in Figure 4-4.

Figure 4-4.  Hardware Digital Trigger Dialog Box
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Table 4-3 contains a list of Hardware Digital Trigger choices with

descriptions of their use.

Table 4-3. Choices for Hardware Digital Trigger

Choices for Hardware

Digital Trigger Description

Start acquisition on trigger Select this option if you want to start your acquisition on

the rising edge of the PFI0/EXTTRIG/STARTTRIG

(depending on the board you are using) input on the

connector. Otherwise, Measure starts the acquisition

with a software trigger.

Acquire until trigger Select this option if you want to stop your acquisition on

the rising edge of the PFI1/EXTTRIG/STOPTRIG

(depending on the board you are using) signal on the

connector. Otherwise, the acquisition ends after Measure

acquires all the scans.

scans after trigger Specify the number of scans to acquire after the stop

trigger occurs.

Timeout (seconds) Specify a timeout value in seconds. If you want Measure

to calculate a timeout value for you, enter -1. If you

specify an externally generated scan clock and a timeout

value of –1, Measure disables the timeout. You can stop

the acquisition by pressing the <Q> key.

Mode Reference

The Analog Input Mode applies to all the channels in your scan list.

Select Analog Input Configuration»Mode to open the Analog Input

Mode dialog box, as shown in Figure 4-5.

Note: The Mode button is disabled in the Analog Input Configuration dialog box

when you select Use Named Channels for your data acquisition device in the

DAQ Tasks dialog box.
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Figure 4-5.  Analog Input Mode Dialog Box

Table 4-4 contains a list of Analog Input Mode choices with

descriptions of their use.

Table 4-4.  Choices for Analog Input Mode Dialog Box

Choices for Analog Input Mode Description

Differential Channels Select this option if you want each channel to use two

analog channel input lines. One line connects to the

positive input of the device amplifier, and the other

connects to the negative input of the amplifier. Refer to

the user manual for your DAQ device for more

information about input modes available on your device.

Referenced Single-Ended Channels Select this option if you want each channel to use one

analog input channel line, which connects to the positive

input of the amplifier. The negative input of the

amplifier is internally tied to analog input ground

AIGND. Refer to the user manual for your DAQ device

for more information about input modes available on

your device.

Non-Referenced Single-Ended

Channels

Select this option if you want each channel to use one

analog input channel line, which connects to the positive

input of the amplifier. The negative input of the

amplifier connects to the analog input sense AISENSE

input. Refer to the user manual for your DAQ device for

more information about input modes available on your

device.
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Note: The Analog Input Mode on some devices is not configurable within Measure.

If you have such a device, you must exit Measure and change the mode using

the NI-DAQ Configuration Utility. If you have a device with jumpers, you

must exit Measure, power down your computer, change the jumpers, and run

the NI-DAQ Configuration Utility to configure the new setting. Refer to the

NI-DAQ User Manual that came with your device for more information.

Advanced Timing Settings

Usually, you do not configure the advanced timing settings because

Measure automatically selects reasonable values for you. In some

cases, however, you might want to select an interchannel delay or an

external channel clock. You can configure these settings through the

Advanced Timing Settings dialog box, as shown in Figure 4-6.

Figure 4-6.  Advanced Timing Settings Option

Table 4-5 contains a list of the Advanced timing settings with

descriptions of their use.

Table 4-5.  Choices for Advanced Timing

Choice for Advanced Timing Description

Let NI-DAQ choose an interchannel

delay

NI-DAQ calculates an interchannel delay for you, based

on your hardware, the limit settings for the task, and the

scan rate for the task.

Specify interchannel delay (µS) Measure uses the interchannel delay you specify in

microseconds.

Use external channel clock Measure configures your DAQ device to use an external

channel clock.
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Analog Output Reference

This chapter introduces some concepts of data acquisition and contains

a reference for basic and advanced analog output configuration. You

should be familiar with the hardware capabilities of your data

acquisition device.

Analog Output Configuration Overview

Select DAQ»Configure DAQ Tasks and click on the AO button to

open the Analog Output Configuration dialog box, as shown in

Figure 5-1.

Figure 5-1.  Analog Output Configuration Dialog Box
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Note: The Advanced button is disabled in the Analog Output Configuration dialog

box when you select Use Named Channels for your data acquisition device in

the DAQ Tasks dialog box.

Table 5-1 describes the fields within the Analog Output Configuration

dialog box.

Table 5-1.  Analog Output Configuration Reference

Option Description

Channel Specify the analog output channel on which to generate a signal. You

can specify only one channel at a time.

Data cells Specify the source range of the voltage values to write to the digital-to-

analog converter (DAC) for the channel. Either explicitly type the cell

address, or highlight the text in this field and then select a row of cells

or a column of cells on any worksheet in the workbook. Measure

automatically records the address of your selection in this field.

Add>> Click this button after specifying a channel and a data cells range.

Remove Click this button to remove any channels or source ranges that you

selected in the list box.

Number of iterations Specify the number of times Measure should iterate through the

waveform that you specified for a channel. If you specify 0 for the

number of iterations, Measure indefinitely iterates through the

waveform until you run another signal generation task on that same

device or until you exit Excel.

Updates per second Specify the rate at which Measure writes the voltage values to the

DAC. If you specified more than one channel in your channel list, all

channels will have the same update rate.

Task Name When you create a new AO task, Measure suggests a unique name for

your new task. You can change the name in the Task name edit box;

However, the name must be unique to the active workbook.

Description Click on this button to enter a short description of your task. Measure

displays a description of a task below the task list in the DAQ Tasks

dialog box. Also, if you add your task to the DAQ menu, Measure

displays the task description in the Excel status bar at the bottom of its

window when you select the task from the menu.

Advanced Click on this button to configure more of the advanced properties for

the analog output task.
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Option Description

OK Verify configuration and add a new task or update an existing task in

the data acquisition tasks lists. Return to the DAQ Tasks dialog box.

Cancel Ignore changes and return to the DAQ Tasks dialog box.

Note: If you want to generate waveforms on more than one channel, you must add

each channel separately to the channel list. Also, Measure requires that all

channels have the same number of voltage values to generate.  If the range of

data for one channel is larger than for another channel in the scan list, the

shorter range of data is padded with the value 0 when Measure generates the

waveforms.

Advanced Configuration

For most tasks, it is not necessary to use the Advanced Analog Output

Configuration dialog box, as shown in Figure 5-2. You cannot use it if

you selected Use Named Channel as your data acquisition device. With

this dialog box, you can change the output range of your device by

specifying new high and low limits, or you can specify a current

channel type, if your device supports it. Refer to Table 5-2 for detailed

information.

Figure 5-2.  Advanced Analog Output Configuration Dialog Box
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Table 5-2. Advanced Analog Output Configuration Options

Option Description

High Limit (volts) The high limit is equal to your reference voltage and is the maximum

voltage the DAC can produce. If you have an AT-AO-6/10 board and

your Channel Type is current, you can calculate the maximum possible

current with the following equation.

Imax = Vref + 2.5/0.625  mA

The following list contains the default settings for high limit. If you

want to use a high limit that differs from the ones given in this list, you

must supply an external voltage reference on the EXTREF pin of the

connector and select the External Voltage Reference option.

Most devices:          10.0 V

Lab/1200 Series:  -5.0 V or 10.0 V

Low Limit (volts) The low limit is either 0.0 Volts or a value equal to, but opposite in

sign, to the upper limit.

External Voltage

Reference

Select this option if you want to supply an external voltage reference

on the EXTREF pin of the connector.
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Using Measure Data

Acquisition Tasks with VBA

This chapter describes how to run tasks from within Visual Basic for Applications.

There are two ways to execute DAQ Add-In functions in a VBA module.

1. Indirectly, you can use Application.Run

returnValue=Application.Run(“FuncName”, arg1)

Application.Run “FuncName”, arg1

2.  Directly, after you add a reference to the DAQ Add-In.  To add a reference to the

DAQ Add-In, select Tools»References and select the checkbox next to the Data

Acquisition Add-In.

returnValue = FuncName(arg1)

FuncName arg1

Function Reference

The DAQ Add-In has one function that you can call to run a task that has been

configured already and one function to translate an error code to an error description.

DAQ

Runs the task named TaskName.

Syntax

Function DAQ(TaskName as String, [NewTargetRange as String],

[ReferenceStyle as Variant]) as Integer
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Parameters

Option Description

TaskName The name of a task in the active workbook.

NewTargetRange The address of a range on a worksheet that receives the acquired data.

If you fail to specify a worksheet explicitly in the address of this

macro, Measure assumes that the range is on the active worksheet.  If

no worksheet is active, Measure returns an error.  If this parameter is

missing, Measure uses the previously configured range.

ReferenceStyle Use either xlA1 or xlR1C1 to indicate the type of range address being

passed into NewTargetRange.  If this parameter is missing, then

Excel’s current reference type is assumed.

Return Value

Returns 0 if successful, otherwise returns an error code. Refer to Appendix B, Error

Codes for more information.

Example

‘Referenced not added to DAQ Add-In; use indirect method

Sub RunMyTask()

Dim iErr As Integer

iErr = Appliction.Run(“DAQ”, “AI1”)

If iErr <> 0 Then

MsgBox Application.Run(“GetDAQErrorMessage”, iErr)

End If

End Sub

‘Referenced added to DAQ Add-In; use direct method

Sub RunMyTask()

Dim iErr As Integer

iErr = DAQ(“AI1”)

If iErr <> 0 Then

MsgBox GetDAQErrorMessage(iErr)

End If

End Sub
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GetDAQErrorMessage

Finds and returns a description of an error code returned by the DAQ function.

Syntax

Function GetDAQErrorMessage(ErrorCode As Integer) As String

Parameters

Option Description

ErrorCode A non-zero number returned by the DAQ function that indicates an

error.

Return Value

A short description of the error code.

Example

See the previous example for the DAQ function.
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DAQ Hardware Capabilities

This appendix contains tables that summarize the analog I/O

capabilities of National Instruments data acquisition (DAQ) devices

you might use with Measure for Windows. The devices in this

appendix are grouped into categories. The DAQ device categories for

these tables include the following.

• MIO and AI Devices

• Lab, 1200 Series, and Portable Devices

• SCXI Modules

• Analog Output Only Devices

MIO and AI Device Hardware Capabilities

Table A-1.  Analog Input Configuration Programmability – MIO and AI Devices

Device Gain Range Polarity SE/DIFF Coupling

All MIO-E Series Devices
1

All AI-E Series Devices

By channel By channel By channel By channel DC

AC, DC (for PCI-6110E,

PCI-6111E)

AT-MIO-16F-5 By channel By group By group By group DC

AT-MIO-64F-5

AT-MIO-16X

By channel By channel By channel By channel DC

AT-MIO-16/16D By channel By device By device By device DC

1 The 64-channel MIO E-series boards have unusual scan strings when the analog input is differential. For example,

the possible channels needed to acquire data from a differential input situation is 0:7, 16:23, and etc.

“By device” means you select the value of a parameter with hardware jumpers, and the selection affects any group of

channels on the device. “By group” means you program the selection through software, and the selection affects all

the channels used at the same time. “By channel” means you program the selection with hardware jumpers or

through software on a per channel basis. When a specific value for a parameter is shown, that parameter value

is fixed.
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Table A-2.  Analog Input Characteristics – MIO and AI Devices (Part 1)

Device

Number of

Channels Resolution Gains
1

Range (V)
1

Input FIFO

(words) Scanning
2

AT-MIO-16E-1

AT-MIO-16E-2

AT-MIO-16E-10

AT-MIO-16DE-10

PCI-MIO-16E-1

PCI-MIO-16E-4

16SE, 8DI 12 bits 0.5, 1, 2, 5,

10, 20, 50,

100

±5, 0 to 10 512; E-1:

8,192; E-2 and

E4: 2,048

Up to 512

PCI-6110E

PCI-6111E

4 DI

2 DI

12 bits

12 bits

0.2, 0.5,  1.2,

5, 10, 20, 50

±10 512 Up to 4

Up to 2

AT-MIO-64E-1
3

64SE, 32DI 12 bits 0.5, 1, 2, 5,

10, 20, 50,

100

±5, 0 to 10 2,048 Up to 512

PCI-MIO-16XE-10

PCI-6032E  (AI-16XE-10)

16SE, 8DI 16 bits 1, 2, 5, 10,

20, 50,100

±10, 0 to 10 512 Up to 512

PCI-6031E

(MIO-64XE-10) 
3

PCI-6033E (AI-64XE-10) 
3

VXI-MIO-64XE-10 
3

64SE, 32DI 16bit 1, 2, 5, 10,

20, 50, 100

±10, 0 to 10 512 Up to 512

PCI-6071E

(MIO-64E-1) 
3

VXI-MIO-64E-1 
3

64SE, 32DI 12 0.5, 1, 2, 5,

10, 20, 50,

100

5 to -5 and 0

to 10

8192 Up to 512

PXI-6040E (MIO-16E-4)

PXI-6070E (MIO-16E-1)

16SE, 8DI 12 bit 0.5, 1, 2, 5,

10, 20, 50,

100

5 to -5 and 0

to 10

1024  (6040E)

8192 (6070E)

Up to 512

AT-MIO-16F-5

AT-MIO-64F-5**

16SE, 8DI

64SE, 32DI

12 bits 0.5, 1, 2, 5,

10, 20, 50,

100

±5, ±10, 0 to

10

16F-5: 256;

64F-5: 512

Up to 512

AT-MIO-16X 16SE, 8DI 16 1, 2, 5, 10,

20, 50, 100

±10, 0 to 10 512 Up to 512

AT-MIO-16(L)

AT-MIO-16(H)

AT-MIO-16D(L)

AT-MIO-16D(H)

16SE, 8DI 12 (L) 1, 10,

100, 500;

(H): 1, 2, 4, 8

±5, ±10, 0 to

10

16 (L,H);

512 (DL, DH)

Up to 16

1 You can determine the limit settings of your device by multiplying the range and the voltage values together. For

more information on limit settings in LabVIEW, refer to the Basics LabVIEW Data Acquisition Concepts chapter in

the LabVIEW Data Acquisition Basics Manual.
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2 Scanning = channels, in any order.

3 The valid channels for the 64-channel MIO E-series boards in Differential Mode are 0-7, 16-23, 32-39, and 48-55.

** The valid channels for the AT-MIO-64F-5 in Differential Mode are 0-7 and 16-39.

Table A-3.  Analog Input Characteristics – MIO and AI Devices (Part 2)

Device Triggers1

Max Sampling

Rate (S/s) Transfer Method

AT-MIO-16E-1

AT-MIO-16E-2

AT-MIO-64E-11

AT-MIO-16E-10

AT-MIO-16DE-10

AT-MIO-16XE-10

PCI-MIO-16E-1

PCI-MIO-16XE-10

PCI-MIO-16E-4

PXI-6040E (MIO-16E-4)

PXI-6070E (MIO-16E-1)

PCI-6071E (MIO-64E-1)

PCI-6031E (MIO-64XE-10)

PCI-6032E (AI-16XE-10)

PCI-6033E (AI-64XE-10)

PCI-6110E

PCI-6111E

VXI-MIO-64E-1

VXI-MIO-64XE-10

SW, Pre, Post, (and Analog

on E-1, E-2, E-3, E-4 PCI-

6110E, and

PCI-6111E)

E-1: 1 M, E-2 and E-3: 500 k,

E-4: 250 k, E-10 and DE-10: 100 k

PCI-6110E and PCI-6111E: 5M

DMA, interrupts

All MIO-16XE-50 Devices SW, Pre, Post 20 k DMA (interrupts on

DAQPad-MIO-16XE-

50)

AT-MIO-16F-5

AT-MIO-64F-5

SW, Pre, Post 200 k DMA, interrupts

AT-MIO-16X

AT-MIO-16/16D

SW, Pre, Post 100 k DMA, interrupts

1 SW=Software Triggering (also called conditional retrieval), Pre=Pretrigger, Post=Posttrigger.



Appendix A    DAQ Hardware Capabilities

Measure Data Acquisition User Manual A-4 © National Instruments Corporation

Table A-4.  Internal Channel Support – MIO and AI Devices

Device Internal Channels

AT-MIO-16XE-10

AT-MIO-16XE-50

DAQPad-MIO-16XE-50

_AIGnd , _Ref5V , _AOGnd , _AO0vsAOGnd , _AO0vsRef5V , _A01 , _AO1vsRef5V

DAQCard-AI-16E-4 _AIGnd , _Ref5V , _A0Gnd

PCI-MIO-16XE-10

PCI-MIO-16XE-50

PXI-6030E

PXI-6011E

PCI-6031

CPCI-6030E

CPCI-6011E

VXI-MIO-64XE-10

_AIGnd , _Ref5V , _AOGnd , _AO0vsAOGnd , _AO0vsRef5V , _AO1vsAOGnd ,

_AO1vsRef5V , _AO1VsAO0 , _DevTemp

PCI-MIO-16E-1

PCI-MIO-16E-4

PXI-6070E

PXI-6040E

PCI-6071E

CPCI-6070E

CPCI-6040E

VXI-MIO-64E-1

_AIGnd , _Ref5V , __CMRef5V , __AOGnd , __AO0vsAOGnd , _AO0vsRef5V ,

__AO1vsAOGnd , _AO1vsRef5V , __AO1VsAO0 , __DevTemp

AT-AI-16XE-10

PCI-6032E

PCI-6033E

DAQCard-AI-16XE-50

_AIGnd , _Ref5V , __A0Gnd

AT-MIO-16E-1

AT-MIO-16E-2

AT-MIO-16E-3

AT-MIO-16DE-10

AT-MIO-16E-10

DAQPad-6020E

_AIGnd , _Ref5V , _CMRef5V , _AOGnd , _AO0vsAOGnd , _AO0vsRef5V ,

_AO1vsAOGnd , _AO1vsRef5V
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Table A-5.  Analog Output Characteristics – MIO and AI Devices

Device

Channel

Numbers DAC Type

FIFO

Size

Output

Limits (V) Update Clocks

Transfer

Method

AT-MIO-16E-1

AT-MIO-16E-2

AT-MIO-64E-3

VXI-MIO-64E-1

0, 1 12-bit double

buffered

2048 0 to 10, ±10,

±Vref, 0 to

Vref ±Vref

Update clock 1 or

external update.

DMA,

interrupts

AT-MIO-16E-10

AT-MIO-16DE-10

12-bit double

buffered

0 ±10, 0 to 10, 0

to Vref, ±Vref

Update clock 1 or

external update.

DMA,

Interrupts

AT-MIO-XE-50 12-bit double

buffered

0 ±10 Update clock 1 or

external update.

DMA,

Interrupts

DAQPad-

MIO-16XE-50

12-bit double

buffered

0 ±10 Update clock 1 or

external update.

Interrupts

AT-MIO-16XE-10

VXI-MIO-64XE-10

PCI-MIO-16XE-10

CPCI-6030E

PXI-6030E

PCI-6031E

16-bit double

buffered

2048 ±10,

0 to 10

Update clock 1 or

external update.

DMA,

Interrupts

PCI-MIO-16E-1

CPCI-6070E

PXI-6070E

PCI-6071E

12-bit double

buffered

2048 ±10,

0 to 10

Update clock 1 or

external update.

DMA,

Interrupts

PCI-MIO-16E-4

CPCI-6040E

PXI-6040E

12-bit double

buffered

512 ±10,

0 to 10

Update clock 1 or

external update.

DMA,

Interrupts

PCI-MIO-16XE-50

CPCI-6011E

PXI-6011E

12-bit double

buffered

0 ±10 Update clock 1 or

external update.

DMA,

Interrupts

DAQPad-6020E 12-bit double

buffered

0 ±10,

0 to 10

Update clock 1 or

external update.

DMA,

Interrupts

PCI-6110E

PCI-6111E

16-bit double

buffered

4096 ±10 Update clock 1 or

external update.

DMA,

Interrupts



Appendix A    DAQ Hardware Capabilities

Measure Data Acquisition User Manual A-6 © National Instruments Corporation

Device

Channel

Numbers DAC Type

FIFO

Size

Output

Limits (V) Update Clocks

Transfer

Method

AT-MIO-16F-5

AT-MIO-64F-5

0, 1 12-bit double

buffered

(64F-5: 2 K

FIFO)

0 to 10, ±10,

±Vref, 0 to

Vref

Update clock 1 is

first available of ctr

5, 2, 1 or external

update. Default is 5.

Timebase signal

range is 5,000,000,

1,000,000, 100,000,

10,000, 1,000, and

100.

DMA,

interrupts

AT-MIO-16X 0, 1 16-bit double

buffered

(2 K FIFO)

±10, 0 to 10,

±Vref, 0 to

Vref

Update clock 1 is

first available on ctr

5, 2, 1, or external

update. Timebase

signal range is

5,000,000,

1,000,000, 100,000,

10,000, 1,000, 100.

DMA,

interrupts

AT-MIO-16/16D 0, 1 12-bit double

buffered

0 to 10, ±10,

±Vref, 0 to

Vref

Update clock 1 is

ctr2 or external

update. Timebase

signal range is

1,000,000, 100,000,

10,000, 1,000, and

100.

Interrupts
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Table A-6.  Analog Output Characteristics – E series devices

Device

Reglitching

Capable

Ground

Reference

Capable

Can Control

FIFO Request

Modes

AO Gating,

Pause/Resume

Supported

Multiple

Buffers

Supported

AT-MIO-16E-1

AT-MIO-16E-2

AT-MIO-64E-3

VXI-MIO-64E-1

Yes No No No Yes

AT-MIO-16E-10

AT-MIO-16DE-10

No No No Yes Yes

AT-MIO-XE-50 No No No No Yes

DAQPad-MIO-16XE-50 No No No No Yes

AT-MIO-16XE-10 No No No Yes Yes

VXI-MIO-64XE-10 No No No No Yes

PCI-MIO-16E-1

CPCI-6070E

PXI-6070E

PCI-6071E

Yes Yes Yes Yes No

PCI-MIO-16E-4

CPCI-6040E

PXI-6011E

No Yes Yes Yes No

PCI-MIO-16XE-50

CPCI-6011E

PXI-6011E

No No No Yes No

PCI-MIO-16XE-10

CPCI-6030E

PXI-6030E

PCI-6031E

No No Yes Yes No

DAQPad-6020E No Yes No Yes No

PCI-6110E

PCI-6111E

No No Yes Yes No

* Short form factor AT-MIO-16E-10 only
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Lab, 1200 Series, and Portable Devices
Hardware Capabilities

Note: With all the MIO and AI Device You must have a scan string that is

contiguous, from highest to lowest channel number, and the scan string must

include zero.

Table A-7.  Analog Input Configuration Programmability – Lab, 1200 Series, and Portable Devices

Device Gain Range Polarity SE/DIFF Coupling

Lab-PC+ By group By group By device By device DC

SCXI-1200

DAQPad-1200

DAQCard-1200

PCI-1200

By group By group By group By group DC

DAQCard-500 1 Only 1 range

available

Bipolar SE DC

DAQCard-516

PC-516

1 Only 1 range

available

Bipolar By group DC

DAQCard-700 1 By group Bipolar By group DC

PC-LPM-16 1 By device Bipolar SE DC

Note: “By device” means you select the value of a parameter with hardware

jumpers, and the selection affects any group of channels on the device. “By

group” means you program the selection through software, and the selection

affects all the channels used at the same time. “By channel” means you

program the selection with hardware jumpers or through software on a per

channel basis. When a specific value for a parameter is shown, that

parameter value is fixed.
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Table A-8.  Analog Input Characteristics – Lab, 1200 Series, and Portable Devices (Part 1)

Device

Number of

Channels

Resolution

(bits) Gains
1

Range (V)
1

Input

FIFO

(samples)

Lab-PC+*

SCXI-1200

DAQPad-1200

DAQCard-1200*

PCI-1200

8SE, 4DI 12 1, 2, 5, 10 20,

50, 100

±5, 0 to 10 2,048;

Lab-PC: 512

DAQCard-500 8SE 12 1 ±5 16

DAQCard-516

PC-516

8SE,4DI 16 1 ±5V 512

DAQCard-700 16SE, 8DI 12 1 ±10, ±5, ±2.5 512

PC-LPM-16 16SE 12 1 ±5, ±2.5, 0 to 10, 0 to 5 16

1 You can determine the limit settings of your device by multiplying the range and the voltage values together. For

more information on limit settings in LabVIEW, refer to the Basics LabVIEW Data Acquisition Concepts chapter

in the LabVIEW Data Acquisition Basics Manual.

* The valid channels for the Lab-PC+ and DAQCard-1200 in Differential Mode are 6, 4, 2, and 0.

Table A-9.  Analog Input Characteristics – Lab, 1200 Series, and Portable Devices (Part 2)

Device Scanning Triggers

Max Sampling

Rate (S/s)

Transfer

Method

Lab-PC+

SCXI-1200

DAQPad-1200

DAQCard-1200

PCI-1200

Any single channel; for

multiple channels, N through

0, where N<=7.

Software trigger,

pretrigger, and

posttrigger with digital

trigger

100 k; Lab-PC+: 83

k

Interrupts; Lab-

PC+: Interrupts,

DMA

DAQCard-500

DAQCard-516

PC-516

Any single channel; for

multiple channels, N through

0, where N<=7

Software trigger only 50 k Interrupts

DAQCard-700 Any single channel; for

multiple channels, N through

0, where N<=15

Software trigger only 100 k Interrupts

PC-LPM-16 Any single channel; for

multiple channels, N through

0, where N<=15

Software trigger only 50 k Interrupts
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Table A-10.  Analog Output Characteristics – Lab, 1200 Series, and Portable Devices

Device

Channel

#s

DAC

Type

Output

Limits (V)

Update Clocks Waveform

Grouping

Transfer

Methods

Lab-PC+

SCXI-1200

DAQPad-1200

DAQCard-1200

PCI-1200

0, 1 12-bit

double-

buffered

0 to 10, ±5 Update clock 1 is

ctrA2 or external

update; timebase

signal range is

1,000,000, 100,000,

10,000, 1,000, and

100

0, 1, or 0 and 1 Interrupts

Note: The DAQCard-516 and PC 516 devices do not have analog output.

SCXI Module Hardware Capabilities

Table A-11.  Analog Input Characteristics – SCXI Modules

Module

Number of

Channels

Input

Voltage

Range (V) Gains
1

Filter
1

Excitation

Channels
1

Mode

Support

SCXI-1100 32 DI ±10 1, 2, 5, 10, 20,

50, 100, 200,

500, 1,000,

2,000

(SW/M)1

 lowpass filter

(or no filter)

with 10 kHz or

4 Hz cutoff

frequency

(JS/M)1

-- multiplexed

SCXI-1102

SXCI-1102B

SCXI-1102C

VXI-SC-1102

VXI-SC-1102B

VXI-SC-1102C

32 DI ±10 1, 100

(SW/C)1

1 Hz lowpass

on each

channel

-- multiplexed

SCXI-1120

SCXI-1121

8 DI

(SCXI-1120)

4 DI

(SCXI-1121)

±5 1, 2, 5, 10, 20,

50, 100, 200,

500, 1,000,

and 2,000

(JS/C)1

lowpass filter

with 10 kHz or

4 Hz cutoff

frequency

(JS/C)1

SCXI-1121

only: 4 voltage

or current

excitation

JS/C 1

(channels)

multiplexed

or parallel



Appendix A    DAQ Hardware Capabilities

© National Instruments Corporation A-11 Measure Data Acquisition User Manual

Module

Number of

Channels

Input

Voltage

Range (V) Gains
1

Filter
1

Excitation

Channels
1

Mode

Support

SCXI-1120D 8 DI

(SCXI-1120)

4 DI

(SCXI-1121)

±5 0.5, 1, 2.5, 5,

10, 25, 50,

100, 250, 500,

1,000

4,500,

24,500 Hz

SCXI-1121

only: 4 voltage

or current

excitation

JS/C 1

(channels)

multiplexed

or parallel

SCXI-1122 16 DI or 8 DI

and 8

excitation

SW/M1

channels

±10 0.01, 0.02,

0.05, 0.1, 0.2,

0.5, 1, 2, 5,

10, 20, 50,

100, 200, 500,

1,000, 2,000

(SW/M)1

lowpass filter

with 4kHz or 4

Hz cutoff

frequency

8 voltage or

current

excitation

channels in

4-wire

scanning mode

multiplexed

SCXI-1140 8 DI, sample

and hold

±10 1, 10, 100,

200, 500

(DS/C)1

none -- multiplexed

or parallel

SCXI-1141 8 DI ±5 1, 2, 5, 10, 20,

50, 100

(SWy/C)1

elliptic lowpass

filter with

10Hz to 25KHz

cutoff

frequency2

(SW/M)1

(disabled on a

per channel

basis)

-- multiplexed

or parallel

1 DS/C = dip switch-selectable per channel, JS/C = jumper-selectable per channel, JS/M = jumper-selectable per

module, SW/C = software-selectable per channel, SW/M = software-selectable per module

2 The SCXI-1141 has an automatic filter setting. LabVIEW sets the filter frequency based on the scan rates used

with the module.
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Table A-12.  Analog Output Characteristics – SCXI Modules

Module

Number of

Channels Output Voltage Range (V or mA) Mode Support

SCXI-1124 6 voltage or

current

0 to1, 0 to 5, 0 to 10, ±1, ±5, ±10 (software-

selectable) or 0 to 20 mA

multiplexed

Table A-13.  Terminal Block Selection Guide – SCXI Modules

SCXI Module Terminal Blocks Cold-Junction Compensation Sensor (CJC)

SCXI-1100

SCXI-1102

SCXI-1303

SCXI-1300

Thermistor

IC Sensor

SCXI-1120

SCXI-1121

SCXI-1120D

SCXI-1320

SCXI-13211

SCXI-1327

SCXI-1328

IC Sensor

IC Sensor

Thermistor

Thermistor

SCXI-1122 SCXI-1322 Thermistor

SCXI-1124 SCXI-1325 --

SCXI-1140 SCXI-1301

SCXI-1304

--

--

SCXI-1141 SCXI-1304 --

SCXI-1180 SCXI-1302 --

SCXI-1181 SCXI-1300

SCXI-1301

IC Sensor

--

SCXI-1200 SCXI-1302

CB-50

--

--

VXI-SC-1102

VXI-SC-1102B

VXI-SC-1102C

VXI-TB-1303

VXI-TB-96

Thermistor

1 SCXI-1121 only
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Analog Output Only Devices Hardware Capabilities

Table A-14.  Analog Output Characteristics – Analog Output Only Devices

Device

Channel

#s

DAC

Type

Output

Limits (V) Update Clocks

Waveform

Grouping

Transfer

Method

AT-AO-6

AT-AO-10

0 through 5,

6 through 9*

12-bit

double-

buffered

with

1 K FIFO

for

update

clock

1 channels

±10V, ±Vref1,

0 to 10, 0 to

Vref1, 4 to 20

mA,

Update clock 1 is ctr0

or external update.

Update clock 1

channels are 0, 1, 2, 3,

4, 5, 6*, 7*, 8*, 9*, 0 to

1, 0 to 3, 0 to 5, 0 to 7*,

0 to 9*. Update clock 2

is ctr1. Update clock 2

channels are 2, 3, 4, 5,

6*, 7*, 8*, 9*, 2 to 3, 2

to 5, 2 to 7*, 2 to 9*;

timebase signal range is

1,000,000, 100,000,

10,000, 1,000, 100

For update

clock 1

channels are

any one

channel N or

set of channel

pairs: 0-N; for

update clock 2

channels are 2-

N, same rules

as above: N#6,

N#10*

Update

clock 1

channels:

DMA,

interrupts;

update

clock 2

channels:

interrupts

PC-AO-2DC

(Plug and

 Play)

0, 1 0 to 10V, ±5V,

0-20mA sink

software-

selectable

DAQCard-

AO-2DC

0, 1 0 to 10V, ±5V,

0--20mA sink

software-

selectable

VXI-AO-

48XDC

voltage 0

through 47,

current 0

through 47

18-bit -10.1 V to +10.1

V, 0.1 mA to

20.1 mA source,

voltage and

current channels

are

independent
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Error Codes

This appendix describes the errors that can occur while using the

Measure DAQ Add-In.

Table B-1.  Data Acquisition Error Codes

Error Code Error Description

-2001 Unable to find task.

-2002 The worksheet that is specified in the task’s configuration does not exist.

-2003 The range that is specified in the task's configuration is not valid.

-2004 Excel is out of memory. Use a smaller range.

-2101 An analog output channel string represents multiple analog output channels.

Measure requires that each analog output channel string contain only one

analog output channel.

-10001 An error was detected in the input string; the arrangement or ordering of the

characters in the string is not consistent with the expected ordering.

-10002 An error was detected in the input string; the syntax of the string is correct, but

certain values specified in the string are inconsistent with other values

specified in the string.

-10003 The value of a numeric parameter is invalid.

-10004 The value of a numeric parameter is inconsistent with another one, and

therefore the combination is invalid.

-10005 The device is invalid.

-10006 The line is invalid.

-10007 A channel, port, or counter is out of range for the device type or device

configuration; or the combination of channels is not allowed; or the scan order

must be reversed (0 last).

-10008 The group is invalid.

-10009 The counter is invalid.

-10010 The count is too small or too large for the specified counter, or the given I/O

transfer count is not appropriate for the current buffer or channel

configuration.

-10011 The analog input scan rate is too fast for the number of channels and the

channel clock rate; or the given clock rate is not supported by the associated

counter channel or I/O channel.
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-10012 The analog input or analog output voltage range is invalid for the specified

channel, or you are writing an invalid voltage to the analog output.

-10013 The driver returned an unrecognized or unlisted error code.

-10014 The group size is too large for the board.

-10015 The time limit is invalid.

-10016 The read count is invalid.

-10017 The read mode is invalid.

-10018 The offset is unreachable.

-10019 The frequency is invalid.

-10020 The timebase is invalid.

-10021 The limits are beyond the range of the board.

-10022 Your data array contains an incomplete update, or you are trying to write past

the end of the internal buffer, or your output operation is continuous and the

length of your array is not a multiple of one half of the internal buffer size.

-10023 The write mode is out of range or is disallowed.

-10024 Adding the write offset to the write mark places the write mark outside the

internal buffer.

-10025 The requested input limits exceed the board's capability or configuration.

Alternative limits were selected.

-10026 The requested number of buffers or the buffer size is not allowed. For

example, the buffer limit for Lab and 1200 devices is 64K samples, or the

board does not support multiple buffers.

-10027 For DAQEvents 0 and 1 general value A must be greater than 0 and less than

the internal buffer size. If DMA is used for DAQEvent 1, general value A

must divide the internal buffer size evenly, with no remainder. If the TIO-10 is

used for DAQEvent 4, general value A must be 1 or 2.

-10028 The cutoff frequency specified is not valid for this device.

-10029 The function you are calling is no longer supported in this version of the

driver.

-10030 The specified baud rate for communicating with the serial port is not valid on

this platform.

-10031 The specified SCXI chassis does not correspond to a configured SCXI chassis.

-10032 The SCXI module slot that was specified is invalid or corresponds to an empty

slot.

-10033 The window handle passed to the function is invalid.

-10034 No configured message matches the one you tried to delete.

-10035 The specified attribute is not relevant.

-10036 The specified year is invalid.

-10037 The specified month is invalid.

-10038 The specified day is invalid.
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-10039 The specified input string is too long. For instance, DAQScope 5102 devices

can only store a string up to 32 bytes in length on the calibration EEPROM. In

that case, please shorten the string.

-10080 The gain is invalid.

-10081 The pretrigger sample count is invalid.

-10082 The posttrigger sample count is invalid.

-10083 The trigger mode is invalid.

-10084 The trigger count is invalid.

-10085 The trigger range or trigger hysteresis window is invalid.

-10086 The external reference is invalid.

-10087 The trigger type is invalid.

-10088 The trigger level is invalid.

-10089 The total count is inconsistent with the buffer size and pretrigger scan count or

with the board type.

-10090 The individual range, polarity, and gain settings are valid but the combination

is not allowed.

-10091 You have attempted to use an invalid setting for the iterations parameter. The

iterations value must be 0 or greater. Your device might be limited to only two

values, 0 and 1.

-10092 Some devices require a time gap between the last sample in a scan and the start

of the next scan. The scan interval you have specified does not provide a large

enough gap for the board. See your documentation for an explanation.

-10093 FIFO mode waveform generation cannot be used because at least one

condition is not satisfied.

-10094 The calDAC constant passed to the function is invalid.

-10095 The calibration stimulus passed to the function is invalid.

-10100 The requested digital port width is not a multiple of the hardware port width or

is not attainable by the DAQ hardware.

-10120 Invalid application used.

-10121 Invalid counterNumber used.

-10122 Invalid paramValue used.

-10123 Invalid paramID used.

-10124 Invalid entityID used.

-10125 Invalid action used.

-10200 Unable to read data from EEPROM.

-10201 Unable to write data to EEPROM.

-10202 You cannot write into this location or area of your EEPROM because it is

write-protected. You may be trying to store calibration constants into a write-

protected area; if this is the case, you should select user area of the EEPROM

instead.
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-10240 The driver interface could not locate or open the driver.

-10241 One of the driver files or the configuration utility is out of date, or a particular

feature of the Channel Wizard is not supported in this version of the driver.

-10242 The specified function is not located in the driver.

-10243 The driver could not locate or open the configuration file, or the format of the

configuration file is not compatible with the currently installed driver.

-10244 The driver encountered a hardware-initialization error while attempting to

configure the specified device.

-10245 The driver encountered an operating-system error while attempting to perform

an operation, or the operating system does not support an operation performed

by the driver.

-10246 The driver is unable to communicate with the specified external device.

-10247 The CMOS configuration-memory for the device is empty or invalid, or the

configuration specified does not agree with the current configuration of the

device, or the EISA system configuration is invalid.

-10248 The base addresses for two or more devices are the same; consequently, the

driver is unable to access the specified device.

-10249 The interrupt configuration is incorrect given the capabilities of the computer

or device.

-10250 The interrupt levels for two or more devices are the same.

-10251 The DMA configuration is incorrect given the capabilities of the

computer/DMA controller or device.

-10252 The DMA channels for two or more devices are the same.

-10253 Unable to find one or more jumperless boards you have configured using the

NI-DAQ Configuration Utility.

-10254 Cannot configure the DAQCard because 1) the correct version of the card and

socket services software is not installed; 2) the card in the PCMCIA socket is

not a DAQCard; or 3) the base address and/or interrupt level requested are not

available according to the card and socket services resource manager. Try

different settings or use AutoAssign in the NIDAQ configuration utility.

-10255 There was an error in initializing the driver for Remote SCXI.

-10256 There was an error in opening the specified COM port.

-10257 Bad base address specified in the configuration utility.

-10258 Bad DMA channel 1 specified in the configuration utility or by the

operating system.

-10259 Bad DMA channel 2 specified in the configuration utility or by the

operating system.

-10260 Bad DMA channel 3 specified in the configuration utility or by the

operating system.

-10261 The user mode code failed when calling the kernel mode code.
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-10340 No RTSI signal/line is connected, or the specified signal and the specified line

are not connected, or your connection to an RDA server either cannot be made

or has been terminated.

-10341 The RTSI signal/line cannot be connected as specified.

-10342 The specified RTSI signal is already being driven by a RTSI line, or the

specified RTSI line is already being driven by a RTSI signal.

-10343 The specified SCXI configuration parameters are invalid, or the function

cannot be executed with the current SCXI configuration.

-10344 The Remote SCXI unit is not synchronized with the host. Reset the chassis

again to resynchronize it with the host.

-10345 The required amount of memory cannot be allocated on the Remote SCXI unit

for the specified operation.

-10346 The packet received by the Remote SCXI unit is invalid. Check your serial

port cable connections.

-10347 There was an error in sending a packet to the remote chassis. Check your serial

port cable connections.

-10348 The Remote SCXI unit is in reprogramming mode and is waiting for

reprogramming commands from the host (NI-DAQ Configuration Utility).

-10349 The module ID read from the SCXI module conflicts with the configured

module type.

-10360 The DSP driver was unable to load the kernel for its operating system.

-10370 The scan list is invalid; for example, you are mixing AMUX-64T channels and

onboard channels, scanning SCXI channels out of order, or have specified a

different starting channel for the same SCXI module. Also, the driver attempts

to achieve complicated gain distributions over SCXI channels on the same

module by manipulating the scan list and returns this error if it fails.

-10400 The specified resource is owned by the user and cannot be accessed or

modified by the driver.

-10401 The specified device is not a National Instruments product, the driver does not

support the device (for example, the driver was released before the device was

supported), or the device has not been configured using the NI-DAQ

Configuration Utility.

-10402 No device is located in the specified slot or at the specified address.

-10403 The specified device does not support the requested action (the driver

recognizes the device, but the action is inappropriate for the device).

-10404 No line is available.

-10405 No channel is available.

-10406 No group is available.

-10407 The specified line is in use.

-10408 The specified channel is in use.

-10409 The specified group is in use.
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-10410 A related line, channel, or group is in use; if the driver configures the specified

line, channel, or group, the configuration, data, or handshaking lines for the

related line, channel, or group will be disturbed.

-10411 The specified counter is in use.

-10412 No group is assigned, or the specified line or channel cannot be assigned to a

group.

-10413 A group is already assigned, or the specified line or channel is already

assigned to a group.

-10414 The selected signal requires a pin that is reserved and configured only by

NI-DAQ. You cannot configure this pin yourself.

-10415 This function does not support your DAQ device when an external multiplexer

(such as an AMUX-64T or SCXI) is connected to it.

-10440 The specified resource is owned by the driver and cannot be accessed or

modified by the user.

-10441 No memory is configured to support the current data-transfer mode, or the

configured memory does not support the current data-transfer mode. (If block

transfers are in use, the memory must be capable of performing block

transfers.)

-10442 The specified memory is disabled or is unavailable given the current

addressing mode.

-10443 The transfer buffer is not aligned properly for the current data-transfer mode.

For example, the buffer is at an odd address, is not aligned to a 32-bit

boundary, is not aligned to a 512-bit boundary, and so on. Alternatively, the

driver is unable to align the buffer because the buffer is too small.

-10444 No more system memory is available on the heap, or no more memory is

available on the device, or insufficient disk space is available.

-10445 The transfer buffer cannot be locked into physical memory. On PC AT

machines, portions of the DMA data acquisition buffer may be in an invalid

DMA region, for example, above 16 megabytes.

-10446 The transfer buffer contains a page break; system resources may require

reprogramming when the page break is encountered.

-10447 The operating environment is unable to grant a page lock.

-10448 The driver is unable to continue parsing a string input due to stack limitations.

-10449 A cache-related error occurred, or caching is not supported in the current

mode.

-10450 A hardware error occurred in physical memory, or no memory is located at the

specified address.

-10451 The driver is unable to make the transfer buffer contiguous in virtual memory

and therefore cannot lock it into physical memory; thus, the buffer cannot be

used for DMA transfers.

-10452 No interrupt level is available for use.

-10453 The specified interrupt level is already in use by another device.
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-10454 No DMA controller is available in the system.

-10455 No DMA channel is available for use.

-10456 The specified DMA channel is already in use by another device.

-10457 DMA cannot be configured for the specified group because it is too small, too

large, or misaligned. Consult the device user manual to determine group

ramifications with respect to DMA.

-10458 The storage disk you specified is full.

-10459 The NI-DAQ DLL could not be called due to an interface error.

-10460 You have mixed VIs from the DAQ library and the _DAQ compatibility

library (LabVIEW 2.2 style VIs). You may switch between the two libraries

only by running the DAQ VI Device Reset before calling _DAQ compatibility

VIs or by running the compatibility VI Board Reset before calling DAQ VIs.

-10461 The specified resource is unavailable because it has already been reserved by

another entity.

-10462 The specified resource has not been reserved, so the action is not allowed.

-10480 The scan list is too large to fit into the mux-gain memory of the board.

-10481 You must provide a single buffer of interleaved data, and the channels must be

in ascending order. You cannot use DMA to transfer data from two buffers;

however, you may be able to use interrupts.

-10540 At least one of the SCXI modules specified is not supported for the operation.

-10541 CTRB1 will drive COUTB1, however CTRB1 will also drive TRIG1. This

may cause unpredictable results when scanning the chassis.

-10560 The DSP handle input is not valid .

-10561 Either DAQ or WFM can use a PC memory buffer, but not both at the same

time.

-10600 No setup operation has been performed for the specified resources. Or, some

resources require a specific ordering of calls for proper setup.

-10601 The specified resources have already been configured by a setup operation.

-10602 No output data has been written into the transfer buffer.

-10603 The output data associated with a group must be for a single channel or must

be for consecutive channels.

-10604 Once data generation has started, only the transfer buffers originally written to

may be updated. If DMA is active and a single transfer buffer contains

interleaved channel-data, new data must be provided for all output channels

currently using the DMA channel.

-10605 No data was written to the transfer buffer because the final data block has

already been loaded.

-10606 The specified resource is not armed.

-10607 The specified resource is already armed.

-10608 No transfer is in progress for the specified resource.
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-10609 A transfer is already in progress for the specified resource, or the operation is

not allowed because the device is in the process of performing transfers,

possibly with different resources.

-10610 A single output channel in a group may not be paused if the output data for the

group is interleaved.

-10611 Some of the lines in the specified channel are not configured for the transfer

direction specified. For a write transfer, some lines are configured for input.

For a read transfer, some lines are configured for output.

-10612 The specified line does not support the specified transfer direction.

-10613 The specified channel does not support the specified transfer direction.

-10614 The specified group does not support the specified transfer direction.

-10615 The clock configuration for the clock master is invalid.

-10616 The clock configuration for the clock slave is invalid.

-10617 No source signal has been assigned to the clock resource.

-10618 The specified source signal cannot be assigned to the clock resource.

-10619 A source signal has already been assigned to the clock resource.

-10620 No trigger signal has been assigned to the trigger resource.

-10621 The specified trigger signal cannot be assigned to the trigger resource.

-10622 The pretrigger mode is not supported or is not available in the current

configuration, or no pretrigger source has been assigned.

-10623 No posttrigger source has been assigned.

-10624 The delayed trigger mode is not supported or is not available in the current

configuration, or no delay source has been assigned.

-10625 The trigger configuration for the trigger master is invalid.

-10626 The trigger configuration for the trigger slave is invalid.

-10627 No signal has been assigned to the trigger resource.

-10628 A signal has already been assigned to the trigger resource.

-10629 The specified operating mode is invalid, or the resources have not been

configured for the specified operating mode.

-10630 The parameters specified to read data were invalid in the context of the

acquisition. For example, an attempt was made to read 0 bytes from the

transfer buffer, or an attempt was made to read past the end of the

transfer buffer.

-10631 Continuous input or output transfers are not allowed in the current operating

mode, or continuous operation is not allowed for this type of device.

-10632 Certain inputs were ignored because they are not relevant in the current

operating mode.

-10633 The specified analog output regeneration mode is not allowed for this board.

-10634 No continuous (double buffered) transfer is in progress for the

specified resource.
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-10635 Either the SCXI operating mode specified in a configuration call is invalid, or

a module is in the wrong operating mode to execute the function call.

-10636 You cannot start a continuous (double-buffered) operation with a synchronous

function call.

-10637 Attempted to configure a buffer after the buffer had already been configured.

You can configure a buffer only once.

-10680 All channels of this board must have the same gain.

-10681 All channels of this board must have the same range.

-10682 All channels of this board must be the same polarity.

-10683 All channels of this board must have the same coupling.

-10684 All channels of this board must have the same input mode.

-10685 The clock rate exceeds the board's recommended maximum rate.

-10686 A configuration change has invalidated the scan list.

-10687 A configuration change has invalidated the acquisition buffer, or an acquisition

buffer has not been configured.

-10688 The number of total scans and pretrigger scans implies that a triggered start is

intended, but triggering is not enabled.

-10689 Digital trigger B is illegal for the number of total scans and pretrigger

scans specified.

-10690 This board does not allow digital triggers A and B to be enabled at the

same time.

-10691 This board does not allow an external sample clock with an external scan

clock, start trigger, or stop trigger.

-10692 The acquisition cannot be started because the channel clock is disabled.

-10693 You cannot use an external scan clock when doing a single scan of a

single channel.

-10694 The scan rate is above the maximum or below the minimum for the hardware,

gains, and filters used.

-10695 You have set up an operation that requires the use of interrupts. DMA is not

allowed. For example, some DAQ events, such as messaging and LabVIEW

occurrences, require interrupts.

-10696 Multi-rate scanning cannot be used with the AMUX-64, SCXI, or

pretriggered acquisitions.

-10697 Unable to convert your timebase/interval pair to match the actual hardware

capabilities of this board.

-10698 You cannot use this combination of scan and sample clock timebases for

this board.

-10699 You cannot use this combination of scan and sample clock source polarities for

this operation and board.

-10700 You cannot use this combination of scan and convert clock signal sources for

this operation and board.
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-10701 The call had no effect because the specified channel had not been set for later

internal update.

-10702 Pretriggering and posttriggering cannot be used simultaneously on the Lab and

1200 series devices.

-10710 The specified port has not been configured for handshaking.

-10720 The specified counter is not configured for event-counting operation.

-10740 A signal has already been assigned to the SCXI track-and-hold trigger line, or

a control call was inappropriate because the specified module is not configured

for one-channel operation.

-10780 When you have an SC2040 attached to your device, all analog input channels

must be configured for differential input mode.

-10781 The polarity of the output channel cannot be bipolar when outputting currents.

-10782 The specified operation cannot be performed with the SC-2040 configured in

hold mode.

-10783 Calibration constants in the load area have a different polarity from the current

configuration. Therefore, you should load constants from factory.

-10800 The operation could not complete within the time limit.

-10801 An error occurred during the calibration process. Possible reasons for this error

include incorrect connection of the stimulus signal, incorrect value of the

stimulus signal, or malfunction of your DAQ device.

-10802 The requested amount of data has not yet been acquired.

-10803 The on-going transfer has been stopped.  This is to prevent regeneration for

output operations, or to reallocate resources for input operations.

-10804 The transfer stopped prior to reaching the end of the transfer buffer.

-10805 The clock rate is faster than the hardware can support. An attempt to input or

output a new data point was made before the hardware could finish processing

the previous data point. This condition may also occur when glitches are

present on an external clock signal.

-10806 No trigger value was found in the input transfer buffer.

-10807 The trigger occurred before sufficient pretrigger data was acquired.

-10808 An error occurred in the parallel port communication with the DAQ device.

-10809 Attempted to start a pulse width measurement with the pulse in the phase to be

measured (e.g., high phase for high-level gating).

-10810 An unexpected error occurred inside the driver when performing this given

operation.

-10840 The contents or the location of the driver file was changed between accesses to

the driver.

-10841 The firmware does not support the specified operation, or the firmware

operation could not complete due to a data-integrity problem.

-10842 The hardware is not responding to the specified operation, or the response

from the hardware is not consistent with the functionality of the hardware.
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-10843 Because of system limitations, the driver could not write data to the device fast

enough to keep up with the device throughput. This error may be returned

erroneously when an overRunErr has occurred.

-10844 New data was not written to the output transfer buffer before the driver

attempted to transfer the data to the device.

-10845 Because of system limitations, the driver could not read data from the device

fast enough to keep up with the device throughput; the onboard device

memory reported an overflow error.

-10846 The driver wrote new data into the input transfer buffer before the previously

acquired data was read.

-10847 New buffer information was not available at the time of the DMA chaining

interrupt; DMA transfers will terminate at the end of the currently active

transfer buffer.

-10848 The driver could not obtain a valid reading from the transfer-count register in

the DMA controller.

-10849 The configuration file or DSP kernel file could not be opened.

-10850 Unable to close a file.

-10851 Unable to seek within a file.

-10852 Unable to read from a file.

-10853 Unable to write to a file.

-10854 An error occurred accessing a file.

-10855 NI-DAQ does not support the current operation on this particular version of

the operating system.

-10856 An unexpected error occurred from the operating system while performing the

given operation.

-10857 An unexpected error occurred inside the kernel of the device while performing

this operation.

-10858 The system has reconfigured the device and has invalidated the existing

configuration. The device requires reinitialization to be used again.

-10880 A change to the update rate is not possible at this time because 1) when

waveform generation is in progress, you cannot change the interval timebase

or 2) when you make several changes in a row, you must give each change

enough time to take effect before requesting further changes.

-10881 You cannot do another transfer after a successful partial transfer.

-10882 The data collected on the Remote SCXI unit was overwritten before it could be

transferred to the buffer in the host. Try using a slower data acquisition rate

if possible.

-10883 New data could not be transferred to the waveform buffer of the Remote SCXI

unit to keep up with the waveform update rate. Try using a slower waveform

update rate if possible.

-10884 Could not rearrange data after a pretrigger acquisition completed.
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-10920 One or more data points may have been lost during buffered GPCTR

operations due to speed limitations of your system.

-10940 No response was received from the Remote SCXI unit within the specified

time limit.

-10941 Reprogramming the Remote SCXI unit was unsuccessful. Please try again.

-10942 An invalid reset signature was sent from the host to the Remote SCXI unit.

-10943 The interrupt service routine on the remote SCXI unit is taking longer than

necessary. You do not need to reset your remote SCXI unit, however, please

clear and restart your data acquisition.
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Troubleshooting

This appendix describes solutions to problems that you might

encounter using the Measure DAQ Add-In.

Problem: No DAQ menu appears.

Solution: From the Tools»Add-Ins. Click on the

Browse button and look for DAQ.XLA in

the directory where you installed Measure.

Once you find it, select it and click on the

OK button. If a dialog box appears with the

message Replace existing

‘DAQ.XLA’? click on the Yes button. You

will see a Measure Data Acquisition Add-In

entry in the list box and the checkbox next

to it will be checked. Click on the OK

button.

Problem: The list of data acquisition devices is empty.

Solution: Verify with the NI-DAQ Configuration

Utility that you have properly installed and

configured your device. Verify that your

device is supported by Measure. Refer to

Appendix A, DAQ Hardware Capabilities.
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Problem: You are using Windows 3.1 or Windows for

Workgroups 3.11 and you get a dialog box

entitled Measure with the message,

Error -10243 The driver could

not locate or open the

configuration file, or the

format of the configuration

file is not compatible with

the currently installed

driver.

Solution: Delete the WDAQCONF.CFG file in your

Windows directory. Then reconfigure your

hardware using the NI-DAQ Configuration

Utility. If the problem persists, contact

National Instruments for an updated version

of the NI-DAQ driver.

Problem: You get a dialog box entitled Measure with

a message that begins Fatal error.

Solution: Congratulations! It is likely that you have

found a deficiency in our code! Please write

down the information in the dialog box as

well as the actions that you took preceding

the error. Try to reproduce the error. Then,

call National Instruments technical support.

Problem: After you remove the Measure Data

Acquisition Add-In in the Add-Ins dialog

box, a dialog box entitled Microsoft Excel

appears with the message Cannot

access ‘DAQ.XLA’.

Solution: Click on the Cancel button. This behavior,

which occurs because of Microsoft Excel or

the OLE libraries, is harmless and you can

safely ignore it.
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessary

to help us solve technical problems you might have as well as a form you can use to comment on

the product documentation. Filling out a copy of the Technical Support Form before contacting

National Instruments helps us help you better and faster.

National Instruments provides comprehensive technical assistance around the world. In the U.S.

and Canada, applications engineers are available Monday through Friday from 8:00 a.m. to

6:00 p.m. (central time). In other countries, contact the nearest branch office. You may fax

questions to us at any time.

Electronic Services

Bulletin Board Support

National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of

files and documents to answer most common customer questions. From these sites, you can also

download the latest instrument drivers, updates, and example programs. For recorded instructions

on how to use the bulletin board and FTP services and for BBS automated information, call

(512) 795-6990. You can access these services at:

United States: (512) 794-5422 or (800) 327-3077

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom: 01635 551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France: 1 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support

To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use

your Internet address, such as joesmith@anywhere.com, as your password. The support files

and documents are located in the /support directories.
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Fax-on-Demand Support

Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
wide range of technical information. You can access Fax-on-Demand from a touch-tone telephone
at (512) 418-1111.

E-Mail Support (Currently USA Only)

You can submit technical support questions to the applications engineering team through e-mail at
the Internet address listed below. Remember to include your name, address, and phone number so
we can contact you with solutions and suggestions.

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical
support number for your country. If there is no National Instruments office in your country,
contact the source from which you purchased your software to obtain support.

Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and

use the completed copy of this form as a reference for your current configuration. Completing this

form accurately before contacting National Instruments for technical support helps our

applications engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem,

include the configuration forms from their user manuals. Include additional pages if necessary.

Name                                                                                                                                                  

Company                                                                                                                                             

Address                                                                                                                                             

                                                                                                                                                              

Fax (         )                                                         Phone (         )                                                       

Computer brand                                     Model                              Processor                              

Operating system: Windows 3.1, Windows for Workgroups 3.11, Windows NT 3.1,

Windows NT 3.5, Windows 95, other (include version number)                                                        

Version of Excel (look at Excel’s About box): 5.0, 5.0c, other                                                           

Clock Speed                     MHz RAM                  MB Display adapter                                  

Mouse            yes              no Other adapters installed                                                         

Hard disk capacity              MB Brand                                                                                       

Instruments used                                                                                                                                

National Instruments hardware product model                                     Revision                       

Configuration                                                                                                                                      

National Instruments software product                                                Version                         

Configuration                                                                                                                                      

The problem is                                                                                                                                    

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

List any error messages                                                                                                                      

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

The following steps will reproduce the problem                                                                                

                                                                                                                                                              

                                                                                                                                                              



Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each

item. Complete a new copy of this form each time you revise your software or hardware

configuration, and use this form as a reference for your current configuration. Completing this

form accurately before contacting National Instruments for technical support helps our

applications engineers answer your questions more efficiently.

National Instruments Products

Data Acquisition Hardware Revision ________________________________________________

Interrupt Level of Hardware ______________________________________________________

DMA Channels of Hardware ______________________________________________________

Base I/O Address of Hardware ____________________________________________________

NI-DAQ Version _______________________________________________________________

Other Products

Computer Make and Model _______________________________________________________

Microprocessor ________________________________________________________________

Clock Frequency _______________________________________________________________

Type of Video Board Installed _____________________________________________________

Operating System _______________________________________________________________

Operating System Version ________________________________________________________

Operating System Mode _________________________________________________________

Programming Language __________________________________________________________

Programming Language Version ___________________________________________________

Other Boards in System __________________________________________________________

Base I/O Address of Other Boards __________________________________________________

DMA Channels of Other Boards ___________________________________________________

Interrupt Level of Other Boards ____________________________________________________



    

For each instrument you are using:

Name of instrument _____________________________________________________________

Manufacturer of instrument _______________________________________________________

Parity: None, Even, Odd, Mark, Space

Baud rate______________________________________________________________________

Stop bits ______________________________________________________________________

Data bits ______________________________________________________________________

Flow control: Hardware, Software, None

Version of Measure: (look at the about box)                                                                                        



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our

products. This information helps us provide quality products to meet your needs.

Title: Measure   Data Acquisition User Manual

Edition Date: August 1998

Part Number: 321004C-01

Please comment on the completeness, clarity, and organization of the manual.

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

If you find errors in the manual, please record the page numbers and describe the errors.

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

                                                                                                                                                              

Thank you for your help.

Name                                                                                                                                                  

Title                                                                                                                                                    

Company                                                                                                                                             

Address                                                                                                                                               

                                                                                                                                                              

Phone (              )                                                                                                                                

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway (512) 794-5678

Austin, TX 78730-5039
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Prefix Meaning Value

p-

n-

µ-

m-

k-

M-

pico-

nano-

micro-

milli-

kilo-

mega-

10-12

10-9

10-6

10-3

103

106

Numbers/Symbols

1D One-dimensional.

2D Two-dimensional.

A

A/D Analog-to-digital.

ADC Analog-to-digital converter. An electronic device, often an

integrated circuit, that converts an analog voltage to a digital

number.

ADC resolution The resolution of the ADC, which is measured in bits. An ADC

with 16 bits has a higher resolution, and thus a higher degree of

accuracy than a 12-bit ADC.

AI Analog input.
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Analog Input The specification of the analog input channels, input

Configuration limits, input mode, and scan rate that Measure will use to

acquire a waveform.

Analog Output The specification of the analog output channels, output

Configuration limits, data points, and update rate that Measure will use to

generate a waveform.

analog trigger A trigger that occurs at a user-selected point on an incoming

analog signal. Triggering can be set to occur at a specified level

on either an increasing or a decreasing signal (positive or

negative slope). Analog triggering can be implemented either in

software or in hardware. When implemented in software

(Measure), all data is collected, transferred into system memory,

and analyzed for the trigger condition. When analog triggering

is implemented in hardware, no data is transferred to system

memory until the trigger condition has occurred.

AO Analog output.

array Ordered, indexed set of data elements of the same type.

Asynchronous A method of data communications in which information is

transmitted one character at a time.  A start bit precedes each

character and a stop bit follows each character.  The start bit

signals the beginning of the character transmission and the stop

bit indicates its completion.  The Serial Add-In uses

asynchronous communications in its data exchanges.

B

bipolar A signal range that includes both positive and negative values–

for example, -5 to 5 V.

buffer Temporary storage for acquired or generated data.

Byte The standard method of representing numbers or characters in a

computers.  Eight binary digits (bits) make up a byte.
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C

channel Pin or wire lead to which you apply or from which you read the

analog or digital signal. Analog signals can be single-ended or

differential. For digital signals, you group channels to form

ports. Ports usually consist of either four or eight digital

channels.

channel clock The clock controlling the time interval between individual

channel sampling within a scan. Boards with simultaneous

sampling do not have this clock.

clock Hardware component that controls timing for reading from or

writing to groups.

conversion device Device that transforms a signal from one form to another. For

example, analog-to-digital converters (ADCs) for analog input,

digital-to-analog converters (DACs) for analog output, digital

input or output ports, and counter/timers are conversion devices.

coupling The manner in which a signal is connected from one location to

another.

D

D/A Digital-to-analog.

DAC Digital-to-analog converter. An electronic device, often an

integrated circuit, that converts a digital number into a

corresponding analog voltage or current.

data acquisition Process of acquiring data, typically from A/D or digital input

plug-in boards.

device A plug-in data acquisition board that can contain multiple

channels and conversion devices.

device number The slot number or board ID number assigned to the board when

you configured it.

DIFF Differential. A differential input is an analog input consisting of

two terminals, both of which are isolated from computer ground

and whose difference you measure.
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DMA Direct memory access. A method by which data you can transfer

data to computer memory from a device or memory on the bus

(or from computer memory to a device) while the processor

does something else. DMA is the fastest method of transferring

data to or from computer memory.

driver Software that controls a specific hardware device, such as a data

acquisition board.

E

EISA Extended Industry Standard Architecture.

external trigger A voltage pulse from an external source that triggers an event

such as A/D conversion.

F

FIFO A first-in-first-out memory buffer. In a FIFO, the first data

stored is the first data sent to the acceptor.

G

gain The factor by which a signal is amplified, sometimes expressed

in decibels.

I

input limits The upper and lower voltage inputs for a channel. You must use

a pair of numbers to express the input limits. The VIs can infer

the input limits from the input range, input polarity, and input

gain(s). Similarly, if you wire the input limits, range, and

polarity, the VIs can infer the onboard gains when you do not

use SCXI.

input range The difference between the maximum and minimum voltages an

analog input channel can measure at a gain of 1. The input range

is a scalar value, not a pair of numbers. By itself the input range
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does not uniquely determine the upper and lower voltage limits.

An input range of 10 V could mean an upper limit of +10 V and

a lower of 0 V or an upper limit of +5 V and a lower limit of

-5 V.

The combination of input range, polarity, and gain determines

the input limits of an analog input channel. For some boards,

jumpers set the input range and polarity, while you can program

them for other boards. Most boards have programmable gains.

When you use SCXI modules, you also need their gains to

determine the input limits.

interrupt A signal indicating that the central processing unit should

suspend its current task to service a designated activity.

I/O Input/output. The transfer of data to or from a computer system

involving communications channels, operator interface devices,

and/or data acquisition and control interfaces.

ISA Industry Standard Architecture.

K

Kwords 1,024 words of memory.

M

MB megabytes of memory

multiplexer A set of semiconductor or electromechanical switches with a

common output that can select one of a number of input signals

and that you commonly use to increase the number of signals

measured by one ADC.

N

NRSE Nonreferenced single-ended.

O

onboard channels Channels provided by the plug-in data acquisition board.
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output limits The upper and lower voltage or current outputs for an analog

output channel. The output limits determine the polarity and

voltage reference settings for a board.

P

PGIA Programmable gain instrumentation amplifier.

postriggering The technique you use on a data acquisition board to acquire a

programmed number of samples after trigger conditions are met.

pretriggering The technique you use on a data acquisition board to keep a

continuous buffer filled with data, so that when the trigger

conditions are met, the sample includes the data leading up to

the trigger condition.

R

Range A group of rows and columns on a spreadsheet.

RMS Root mean square.

RSE Referenced single-ended.

S

scan One reading from each channel or port in an analog or digital

input group.

scan clock The clock controlling the time interval between scans. On

boards with interval scanning support (for example, the

AT-MIO-16F-5), this clock gates the channel clock on and off.

On boards with simultaneous sampling (for example, the

EISA-A2000), this clock clocks the track-and-hold circuitry.

scan rate The number of scans per second. For example, at a scan rate of

10Hz, Measure samples each channel in a group 10 times per

second.

scan width The number of channels in the channel list or number of ports in

the port list you use to configure an analog or digital input

group.
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SCXI Signal Conditioning eXtensions for Instrumentation. The

National Instruments product line for conditional low-level

signals within an external chassis near sensors, so only

high-level signals in a noisy environment are sent to data

acquisition boards.

sec Seconds

single-ended inputs Analog inputs that you measure with respect to a common

ground.

software trigger A programmed event that triggers an event such as data

acquisition.

Synchronous A method of data communications in which a prearranged

number of bits are transferred per second.  Synchronization

occurs before and after the transmission of blocks of data, rather

than before and after every character.  There are no start bits or

stop bits, as there are in asynchronous communications.  All

transmitted bits represent information or are parity bits.  See

Asynchronous.

T

trigger A condition for starting or stopping clocks.

U

unipolar A signal range that is always positive—for example, 0 to 10 V.

update The output equivalent of a scan. One update is one write to each

channel or port in the group. Updates apply to both analog

output and digital output groups.

update rate The number of output updates per second.

update width The number of channels in the channel list or number of ports in

the port list you use to configure an analog or digital output

group.



Glossary

Measure Data Acquisition User Manual G-8 © National Instruments Corporation

V

V volts.

Visual Basic for The programming language built into Microsoft

Applications (VBA) Excel.

Vref Voltage reference.

W

waveform Multiple voltage readings taken at a specific sampling rate.
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A
Acquire until trigger option, Hardware

Digital Trigger dialog box, 4-7

Add button

Analog Input Configuration dialog

box, 2-3, 3-3

Analog Output Configuration dialog

box, 5-1

adding DAQ Add-In manually, 1-3

adding tasks to DAQ menu, 2-8

Advanced Analog Output Configuration

dialog box, 5-3 to 5-4

illustration, 5-3

options (table), 5-4

Advanced button, Analog Output

Configuration dialog box, 5-1

Advanced Timing Settings dialog box

illustration, 4-10

options (table), 4-10

AI option, DAQ Tasks dialog box, 2-2, 2-10

analog input, SCXI modules, 3-2 to 3-4

channel strings syntax (table), 3-4

multiple SCXI modules and

chassis, 3-3 to 3-4

analog input characteristics

Lab, 1200 Series, and portable devices

(table), A-9

MIO and AI devices (table), A-2 to A-3

SCXI modules (table), A-10 to A-11

analog input configuration. See also Analog

Input Configuration dialog box.

advanced timing settings, 4-10

display, 4-6

mode reference, 4-8 to 4-10

scan information, 4-4

selecting channels for scanning, 4-2 to 4-3

task configuration, 2-3 to 2-5

timing settings, 4-4 to 4-5

trigger reference, 4-7 to 4-8

Analog Input Configuration dialog box

Analog Input Scan List, 2-3, 4-2 to 4-4

At Cell, 4-6

Cancel, 4-7

Channels, 2-3, 4-3

Description, 2-4, 4-7

Display section, 2-4, 4-6 to 4-7

External scan clock, 4-5

Hardware Digital Trigger dialog

box, 4-7 to 4-8

High limit, 4-4

illustration, 4-2

In Columns, 4-6

In Rows, 4-6

Low Limit, 4-4

Mode, 4-7

multiple SCXI modules and

chassis, 3-3 to 3-4

Number of scans, 4-4

OK, 4-7

Scale to volts, 4-4

Scan Information section, 2-3 to 2-4,

4-4 to 4-5

Scan Rate section, 2-4, 4-4 to 4-5

Scans/second, 2-4, 4-5

Task Name, 2-4, 4-6

Trigger, 4-7 to 4-8
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analog input configuration programmability

Lab, 1200 Series, and portable devices

(table), A-8

MIO and AI devices (table), A-1

Analog Input Mode dialog box, 4-9 to 4-10

Differential Channels, 4-9

Non-Referenced Single-Ended

Channels, 4-9

Referenced Single-Ended Channels, 4-9

analog output, SCXI modules, 3-5

analog output characteristics

analog output only devices (table), A-13

Lab, 1200 Series, and portable devices

(table), A-10

MIO and AI devices (table), A-5 to A-6

SCXI modules (table), A-12

analog output configuration. See also

Analog Output Configuration dialog

box.

advanced configuration, 5-3 to 5-4

task configuration, 2-3 to 2-5

Analog Output Configuration dialog box

Add, 5-2

Advanced, 5-2

Cancel, 5-3

Channel, 2-6, 5-2

Data cells, 2-6, 5-2

Description, 5-2

illustration, 5-1

Number of Iterations, 2-6, 5-2

OK, 5-3

Remove, 5-2

Task Name, 2-6, 5-2

Updates per Second, 2-6, 5-2

AO option, DAQ Tasks dialog box, 2-6,

2-10

At Cell field, Analog Input Configuration

dialog box, 4-6

B
boards. See DAQ devices.

bulletin board support, D-1

C
channel clock and scan clock (figure), 4-5

Channel field, Analog Output Configuration

dialog box, 2-6, 5-2

channel strings

SCXI analog input, 3-2 to 3-3

valid (table), 3-4, 4-3

Channel Wizard, 1-2, 2-2, 4-2 to 4-3

Channels field, Analog Input Configuration

dialog box, 2-3, 4-3

clocks

External scan clock option, 4-5

scan clock and channel clock (figure), 4-5

Use external channel clock option, 4-10

configuration. See analog input

configuration; analog output

configuration.

customer communication, xi, D-1 to D-2

D
DAQ devices. See also DAQ hardware

capabilities.

configuration error message, C-2

list of data acquisition devices is

empty, C-1

overview, 1-2, 4-1

selecting from DAQ Tasks dialog

box, 2-1 to 2-2

using with Measure, 1-1

DAQ function, 6-1 to 6-2

DAQ hardware capabilities, A-1 to A-13

analog input characteristics

Lab, 1200 Series, and portable devices

(table), A-9

MIO and AI devices (table), A-2 to A-3

SCXI modules (table), A-10

analog input configuration

programmability

Lab, 1200 Series, and portable devices

(table), A-8

MIO and AI devices (table), A-1

analog output characteristics

analog output only devices (table), A-13



Index

© National Instruments Corporation I-3 Measure Data Acquisition User Manual

Lab, 1200 Series, and portable devices

(table), A-10

MIO and AI devices (table), A-5 to A-6

terminal block selection guide, SCXI

modules (table), A-12

DAQ menu

adding tasks, 2-8

no menu appears, C-1

DAQ Tasks dialog box

managing tasks in workbook, 2-9 to 2-10

options (table), 2-10

purpose and use, 2-2

data acquisition boards. See DAQ devices.

Data acquisition device option, DAQ Tasks

dialog box, 2-10

data acquisition tasks. See tasks.

Data acquisition tasks option, DAQ Tasks

dialog box, 2-10

Data cells field, Analog Output

Configuration dialog box, 2-6, 5-2

Delete option, DAQ Tasks dialog box, 2-10

Description button

Analog Input Configuration dialog

box, 2-4, 4-7

Analog Output Configuration dialog

box, 5-2

devices. See DAQ devices.

Differential Channels option, Analog Input

Mode dialog box, 4-9

displaying acquired data, 4-6

documentation

conventions used in manual, x-xi

organization of manual, ix-x

E
Edit DAQ Menu dialog box, 2-8

Edit Menu option, DAQ Tasks dialog

box, 2-10

Edit option, DAQ Tasks dialog box, 2-10

e-mail support, D-2

error codes, B-1 to B-12

Excel error message after removing DAQ

Add-In manually, C-2

external clock

advanced timing settings, 4-10

External scan clock option, 4-5

MIO-E Series devices (note), 4-6

Use external channel clock option, 4-10

External scan clock option, Analog Input

Configuration dialog box, 4-5

External Voltage Reference checkbox,

Advanced Analog Output

configuration dialog box, 5-4

F
Fatal error message, C-2

fax and telephone support, D-2

FaxBack support, D-2

FTP support, D-1

functions

DAQ, 6-1 to 6-2

GetDAQErrorMessage function, 6-3

G
GetDAQErrorMessage function, 6-3

H
Hardware Digital Trigger dialog box

Acquire until trigger, 4-8

scans after trigger, 4-8

Start acquisition on trigger, 4-8

Timeout (seconds), 4-8

High Limit field

Advanced Analog Output configuration

dialog box, 5-4

Analog Input Configuration dialog

box, 4-3

I
In Columns option, Analog Input

Configuration dialog box, 4-6
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In Rows option, Analog Input Configuration

dialog box, 4-6

installation

adding DAQ Add-In manually, 1-3

removing DAQ Add-In manually, 1-3

steps for installation, 1-3

uninstalling Measure, 1-4

interchannel delay

specifying, 4-10

L
Low Limit field

Advanced Analog Output configuration

dialog box, 5-3 to 5-4

Analog Input Configuration dialog

box, 4-2

M
manual. See documentation.

Measure

installing, 1-3

overview, 1-2

uninstalling, 1-4

using with DAQ devices, 1-1

Microsoft Excel error message after

removing DAQ Add-In manually,

C-2

Mode button, Analog Input Configuration

dialog box, 4-7

mode selection, in Analog Input Mode

dialog box, 4-8 to 4-9

multiplexed operating mode, SCXI, 3-1

N
Named channels, 2-2, 2-6, 4-4, 5-2, 5-3

NI-DAQ driver software, configuring, 1-2

Non-Referenced Single-Ended Channels

option, Analog Input Mode dialog

box, 4-9

Number of iterations field, Analog Output

Configuration dialog box, 2-6, 5-2

Number of scans field, Analog Input

Configuration dialog box, 2-4, 4-4

O
operating modes, SCXI modules, 3-1 to 3-3

P
parallel operating mode, SCXI, 3-1

R
Referenced Single-Ended Channels field,

Analog Input Mode dialog box, 4-9

Remove button, Analog Output

Configuration dialog box, 5-1 to 5-2

removing DAQ Add-In manually, 1-3

Excel error message, C-2

round robin scanning (figure), 4-5

Run button

DAQ Tasks dialog box, 2-5, 2-7, 2-10

S
saving tasks, 2-9

Scale to volts checkbox, Analog Input

Configuration dialog box, 4-4

scan clock, external. See clocks.

scan list, analog input, 2-3, 4-2 to 4-4

scan rate

selecting number of scans per second, 4-5

setting, 2-4, 4-4 to 4-5

scans, specifying number for acquisition,

2-3 to 2-4, 4-4

scans after trigger field, Hardware Digital

Trigger dialog box, 4-8

Scans/second field, Analog Input

Configuration dialog box, 2-4, 4-5

SCXI modules. See also DAQ hardware

capabilities.

analog input, 3-2 to 3-4
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channel strings syntax (table), 3-4

multiple SCXI modules and

chassis, 3-3 to 3-4

analog output, 3-5

configuration, 3-1

operating modes, 3-1 to 3-2

overview, 3-1

Signal Conditioning Extension for

Instrumentation (SCXI). See SCXI

modules.

Specify interchannel delay option,

Advanced Timing Settings dialog

box, 4-10

Start acquisition on trigger option,

Hardware Digital Trigger dialog

box, 4-8

T
Task Description option, DAQ Tasks dialog

box, 2-10

Task Name

Analog Input Configuration dialog box,

2-3, 4-2, 4-6

Analog Output Configuration dialog box,

2-6, 5-1 to 5-2

tasks. See also DAQ Tasks dialog box.

acquisition tasks with VBA, 6-1

adding to DAQ menu, 2-8

configuring

advanced analog output configuration,

5-3 to 5-4

advanced timing settings, 4-10

analog input task, 2-3 to 2-5, 4-2 to 4-7

analog output task, 2-5 to 2-7,

5-1 to 5-3

mode reference, 4-8 to 4-9

timing settings, 4-4 to 4-5

trigger reference, 4-7 to 4-8

managing tasks in workbook, 2-9 to 2-10

saving, 2-9

selecting, 2-1 to 2-3

technical support, D-1 to D-2

terminal block selection guide, SCXI

modules (table), A-12

Timeout (seconds) field, Hardware Digital

Trigger dialog box, 4-8

timing settings, 4-4 to 4-5

Advanced Timing Settings dialog

box, 4-10

external scan clock, 4-5

round robin scanning (figure), 4-5

scan clock and channel clock (figure), 4-5

scan rate, 4-5

Trigger button, Analog Input Configuration

dialog box, 4-7

trigger reference, 4-7 to 4-8

troubleshooting, C-1 to C-2

U
uninstalling Measure, 1-4

Updates per second field, Analog Output

Configuration dialog box, 2-6, 5-2

Use external channel clock option,

Advanced Timing Settings dialog

box, 4-10

V
Visual Basic for Applications (VBA)

DAQ function, 6-1 to 6-2

GetDAQErrorMessage function, 6-3

running tasks from, 6-1

voltage limits

analog input

high, 4-3

low, 4-4

analog output

high, 5-4

low, 5-4

voltage reference, external, 5-4

volts, scale for displaying acquired

data in, 4-4
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W
waveforms, generating on more than one

channel (note), 5-3

WDAQCONF utility, 1-1

workbook, managing tasks in, 2-9 to 2-10
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